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About this Manual
This section explains summary, chapter overview, abbreviations, and provides useful information.

The contents in this section are as follows:

- Purpose

- Intended Audience

- Chapter Overview

- Typographical Conventions

- Reference Materials

- Abbreviations

- Export Regulations

- Trademarks

- Requests

- Copyright

 
Purpose

This document describes how to use the Process Discovery.

 
Intended Audience

This manual is intended for Process Discovery users. It is assumed that the end user has a working knowledge of the following topics:

- Database administration

 
Chapter Overview

 
Chapter Title Description

1 Process Discovery Overview Describes Process Discovery overview.

2 Data Requirements for Process Discovery Describes about data requirements for Process Discovery.

3 Preparing Business Data Describes about preparing Business Data.

4 Business Process Analysis and
Interpretation

Describes about business process analysis and interpretation.

5 Process Generator Overview Describes about Process Generator overview.

6 Process Generator Features Explains how to use Process Generator.

7 Process Analyzer Overview Describes about Process Analyzer overview.

8 Process Analyzer Features Explains how to use Process Generator.

9 Fixed-point Monitoring of Business Using
Process Discovery

Describes about fixed-point monitoring of business using Process
Discovery.

10 Process Analysis Using IBPM Events Describes about process analysis using IBPM events.

Appendix A Parameter Ranges Provides details of parameter ranges.

Appendix B Commands Explains how to use commands.

 
Typographical Conventions

The following conventions are used throughout this manual.
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Example Meaning

Command User input that must be typed is identified by the Courier font

screen text - GUI options to be selected by the end user are bold

- GUI options that are emphasized are bold

Reference Reference material or related documentation is specified in italics

Parameter Command parameters are identified by the Courier font

 

Reference Materials

The following related documentation is also available.

Release Notes

Contains an overview of the Analytics software and late-breaking information that could not be included in the manuals

Overview

Describes the architecture and features of the Analytics software

Installation Guide

Explains how to install Analytics

Dashboard / Output Guide

Explains how to use the Analytics Dashboard

Administration Guide

Covers administration tools and tips, message references, and troubleshooting

Analytics Studio Guide

Explains how to use the Analytics Studio to configure parameters that enforce Analytics features

Management Console Guide

Explains how to use the Management Console and Management Commands to configure key parameters, such as how to start/stop the
Analytics software service or how to display the software status

Migration Guide

Explains how to migrate from previous version of the product

Handbook for the Process Discovery

Explains how to operate the Process Discovery briefly

 
Abbreviations

The following abbreviations are used throughout this document.

 
Name Abbreviation

Microsoft(R) Windows Server(TM) 2003, Standard Edition
Microsoft(R) Windows Server(TM) 2003, Enterprise Edition
Microsoft(R) Windows Server(TM) 2003 R2, Standard Edition
Microsoft(R) Windows Server(TM) 2003 R2, Enterprise Edition

Microsoft(R) Windows Server(R) 2008, Standard Edition
Microsoft(R) Windows Server(R) 2008, Enterprise Edition
Microsoft(R) Windows Server(R) 2008 R2 Standard
Microsoft(R) Windows Server(R) 2008 R2 Enterprise

Windows Server

Microsoft(R) Windows Server(TM) 2003, Standard x64 Edition
Microsoft(R) Windows Server(TM) 2003, Enterprise x64 Edition

Windows Server 2003( x64) or Windows Server 2003
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Name Abbreviation

Microsoft(R) Windows Server(TM) 2003 R2, Standard x64 Edition
Microsoft(R) Windows Server(TM) 2003 R2, Enterprise x64 Edition

Microsoft(R) Windows Server(R) 2012
Microsoft(R) Windows Server(R) 2012 Datacenter
Microsoft(R) Windows Server(R) 2012 Standard
Microsoft(R) Windows Server(R) 2012 Foundation

Windows Server 2012

Microsoft(R) Windows(R) XP Professional operating system
Microsoft(R) Windows(R) XP Home Edition operating system

Windows XP or Windows

Microsoft(R) Windows Vista(R) Business
Microsoft(R) Windows Vista(R) Enterprise
Microsoft(R) Windows Vista(R) Ultimate

Windows Vista or Windows

Microsoft(R) Windows(R) 7 Home Premium
Microsoft(R) Windows(R) 7 Professional
Microsoft(R) Windows(R) 7 Ultimate

Windows 7 or Windows

Microsoft(R) Windows(R) 8
Microsoft(R) Windows(R) 8 Pro
Microsoft(R) Windows(R) 8 Enterprise

Windows 8 or Windows

Microsoft(R) Internet Explorer 7.0
Microsoft(R) Internet Explorer 8.0
Microsoft(R) Internet Explorer 9.0
Microsoft(R) Internet Explorer 10.0

Internet Explorer

Red Hat Enterprise Linux AS
Red Hat Enterprise Linux ES
Red Hat Enterprise Linux 5
Red Hat Enterprise Linux 6

Linux

Interstage Application Server Enterprise Edition
Interstage Application Server Standard-J Edition

Interstage Application Server

Interstage Business Process Manager Interstage BPM or IBPM

Oracle Database 10g Enterprise Edition R10.1.0/R10.2.0
Oracle Database 10g Standard Edition R10.1.0/R10.2.0
Oracle Database 10g Standard Edition One R10.1.0/R10.2.0

Oracle10g or Oracle

Oracle Database 11g Enterprise Edition
Oracle Database 11g Standard Edition
Oracle Database 11g Standard Edition One
Oracle Database 11g R2 Enterprise Edition
Oracle Database 11g R2 Standard Edition
Oracle Database 11g R2 Standard Edition One

Oracle11g or Oracle

Microsoft SQL Server 2005 Standard Edition
Microsoft SQL Server 2005 Enterprise Edition

SQL Server 2005 or SQL Server

Microsoft SQL Server 2008 Standard Edition
Microsoft SQL Server 2008 Enterprise Edition

SQL Server 2008 or SQL Server

 
Export Regulations

Fujitsu documents may include special technology regulated by foreign exchange and foreign trade regulation laws. If special technology
is included, permission must be obtained under these laws before exporting a document or providing it to a non-resident.

 
Trademarks

- Microsoft, Windows, and Windows Server are trademarks or registered trademarks of Microsoft Corporation in the United States and
other countries.
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- Oracle and Java are registered trademarks of Oracle and/or affiliates. Other names may be trademarks of their respective owners.

- Linux is a registered trademark or trademark of Linus Torvalds in the United States and other countries.

- Red Hat is a trademark or registered trademark of Red Hat Inc. in the United States and other countries.

- SQL Server is a Microsoft Corporation (USA) product.

- All other company and product names referred to in this document are general trademarks or registered trademarks of their respective
owners.

 
Requests

- This document may be revised without notice.

- Do not pass on this document to other parties without permission.

- Our company bears no responsibility for third-party infringements of patent or other rights arising out of use of the data contained in
this document.

 
Copyright

Copyright 2013 FUJITSU LIMITED

January 2013 First Edition
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Chapter 1 Process Discovery Overview

1.1 High-Level View of Business Process Visualization

1.2 How to Use Business Process Visualizations
 

For analyzing processes in an existing system

- Understand the implementation of real time business process

- Detect irregular processes and identify operational inefficiencies in a business

 
For use as test scenarios when modifying or rebuilding a system

- Used in theoretical assessments

- Used to create data for system testing

- Used to prioritize system testing scenarios

 
Upgrading to a "Visualizable" system

- Used as a measure to enforce business rules

- Used to point out business processes that need improvement
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1.3 Procedure

Refer to Chapter 3 Preparing Business Data for details about preparing data to be used by Process Discovery.

Refer to Chapter 6 Process Generator Features for details on the Process Generator.
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Refer to Chapter 8 Process Analyzer Features for details on the Process Analyzer.

1.4 Technical words of Process Discovery
Some technical words that are frequently used in the Process Discovery are explained.

Model

This represents a unit of Business Analysis.

Event

This represents a specific work. (Estimation, Purchase, Acceptance)

Action

This represents an occurrence of event, and arrow that connects between events is defined as Action.

Action Time

A difference between event occurrence times is defined as Action Time.

Process

An object that events are chronologically connected is defined as Process.

Route

A group of processes, which order of event occurrence is same respectively, is defined as Route.

Process Diagram

A group of whole processes (routes) is defined as Process Diagram.

Property

This is an additional information process possesses. Property can be used for filtering or analyzing of processes.

- 3 -



Chapter 2 Data Requirements for Process Discovery
This chapter covers the key characteristics of the type of data that must be fed into Process Discovery for effective business process
visualization.

2.1 Basic Requirements
 

The source data must include the following three types of information used as the input for Process
Discovery

- Time information

Time when the event occurred

- Event key

Key that identifies a process (business event); at least one event key should exist for each record

- Event type (event name)

Is indicative of the meaning of a business event; for example, the table name might correspond to the event name, or the item value
in the table might correspond to the event name

2.2 Recommended Requirements
The following recommended requirements should be met for greater accuracy of business process visualization using Process Discovery.
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- Related event key

- If each table has a different ID (event key), a common ID (related event key) across all tables is required.

- Number of event types (event types or merged event types)

- There must be enough event types (more than five event types is recommended).

- Time information

- This must be the history of business process execution times (a delivery schedule, however, does not provide suitable time
information).

- This time information cannot be overwritten (it is no longer usable when previous time information is deleted).

- It should provide enough accuracy (for business processes that are updated every minute, dates are not sufficient).

- Data period and amount

- The period of the data must be longer than the average life span of a process.

In order to generate processes certainly using actual business data, enough time for acquiring business data should be taken.

- There must be a reasonable amount of data in the CSV data files (more than ten entries).

- Mainframe system requirements

- The data can be converted to RDB data, which can be forwarded to an open system, and then, be converted into CSV data.

- DB access log requirements (journal)

- It should be a business event log (a physical database log cannot be used).

- Time information must be recorded, and its period renewed.
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2.3 Table Structures that can be Processed
Many different table structures are used in business databases, but only particular data patterns can be used by Process Discovery.

 
Table structures that require processing

Some data will need to be converted into a structure that Process Discovery can use. Do this when outputting the data to CSV. This applies
to the following cases:

- When data making up events is distributed across different tables.

Each event consists of three types of information; event type (or event name), event key, and time information. These must all be
available in one CSV file for Process Discovery. However, the structure of some database tables does not meet this condition.

The following illustration shows an example of this. In a situation where two tables have been associated with ID fields that have no
bearing on the actual business process, the event type can be generated from the table name (which is the CSV file name), but the
event key and time information are in another table, so Process Discovery cannot use the data as is. In this case, by merging the tables
using the ID fields (shown to the right of illustration (A), a CSV file can be created that includes the event ID and time information
in the same table, and can therefore, be used by Process Discovery.

The event type will also be unable to be extracted correctly if, as shown in illustration (B), the event type is in a table separate from
the event key and time information, referenced by a "Status" field. In this case, by merging the tables using the ID fields (shown to
the right of (B), a CSV file can be created that includes the "Status" field, "Order No." field, and "Time" field in the same table, and
can therefore, be used by Process Discovery.

Figure 2.1 Example of event data distributed across multiple tables

- When data is stored in two or more tables

There may be cases where data that should be stored in one table is spread out across several tables. This may occur due to backup
requirements where one month's worth of data is stored in one table. These tables all have the same schema. When this data is applied
to Process Discovery as multiple CSV files, Process Discovery recognizes every CSV file as a different event type. When this situation
occurs, use a text editor to combine all the different CSV files into one before using them in Process Discovery. When making the
conversion, take care of the header rows in the CSV files.

 
Table structures that do not require processing or that have already been processed

Tables are classified into eight different types, based on a combination of the following factors:

- One table or multiple tables

- One piece of information regarding time of actual job executions or multiple pieces

 

- 6 -



 Note

Times that do not relate directly to jobs may be excluded (projected times of delivery, for example, that do not relate to actual job
executions).

- Whether there is a field that indicates the process type

 
Number of tables Pieces of time information Field that indicates the process

type
Classification

One Two or more One Two or more None Exists

○ ○ ○ (1)

○ ○ ○ (2)

○ ○ ○ (3)

○ ○ ○ (4)

○ ○ ○ (5)

○ ○ ○ (6)

○ ○ ○ (7)

○ ○ ○ (8)

Figure 2.2 Example table structure for each classification

- Classification (1)

Processes with only one event type are displayed in this case.
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- Classification (2)

An event type is extracted from one of the tables. The event name will be the CSV filename plus the time field name. The event key
will be the field specified by the event extraction tool. The event time will also be the field specified by the event extraction tool. This
structure is used mainly when tables are created for each different process.

- Classification (3)

Event types are extracted from one table equal to the number of pieces of time information. The event name will be the CSV filename
plus the time field name. This structure is mainly used when one table is created to see the progress of a process.

- Classification (4)

This is similar to classification 3, but the number of processes to be analyzed is greater.

- Classification (5)

The number of fields in the table that indicate the event type is greater than one. The event name will be the CSV filename plus the
names of the items used to classify events (if more than one, they will be put one after the other) plus the time field name.

This structure is used mainly when one table is created for the purpose of managing the history of a process.

- Classification (6)

This represents a case where a variety of processes are viewed from different perspectives, with each being managed using the method
described in classification 5.

- Classification (7)

This represents a case where a group of events (equal to the number of pieces of time information) is treated as one record. For example,
each process (for example, ordering or estimating) has a start time and a finish time. The table might, therefore, have fields for the
different process, start times, and finish times.

- Classification (8)

This is similar to classification 7, but the number of processes to be analyzed is greater.
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Chapter 3 Preparing Business Data
It is assumed that the data to be processed by Process Discovery is in the CSV format, converted from the data used in an RDB system.

This chapter explains the preparations and precautions when analyzing data with the Process Discovery tool.

3.1 Extracting Business Data
Extract data to the CSV format and ensure the first line of the CSV is a header with the titles of the items in the following rows

3.2 Checking and Normalizing Data
This section explains what measures need to be taken when CSV format data cannot be obtained.

The following data formats can be used as input:

- Plain text

- Excel file

- Database dump files

3.2.1 Plain Text
Plain text can be in one of the following formats:

 
CSV

- Ensure each CSV file has a header row.

If there is no header row, open the file in a text editor, and add an appropriate header.

 
Tab separated values

Open the file in a text editor, and replace the tabs with commas. After this conversion, follow the other points noted for CSV files.

 
Other text formats

If possible, convert to CSV format. This may be achieved with macro features available in some text editors. After this conversion, follow
the other points noted for CSV files.

3.2.2 Excel Files
Save the Microsoft Excel file in the CSV format. After this conversion, follow the other points noted for CSV files. Note the following
points when saving the file:

- Open the converted file in an editor to ensure that data, particularly those pertaining to time, have been saved as expected.

Depending on the cell formatting, precision down to the second, or time may be output as numeric values.

- Strings starting with "0" may be treated as numeric values. Leading zeros ("0") are not output if this is the case (for example, "00012345"
may be output as "12345").

Because event IDs are treated as strings, "00012345" and "12345" would be determined as different values in Process Discovery.

- Cells may include linefeeds. Ensure that the file conforms to the CSV formatting rules described above, or delete the linefeeds within
cells before converting to CSV.

3.2.3 Database Dump Files
Extract dump files from the business system and load them into another database environment. After that, convert the data into CSV
format.
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Refer to the database manual for information on extracting dump files and loading data.

3.2.4 Confirmation after Normalization
Confirm that the generated CSV data meets the following conditions by using Excel or similar products:

- The number of columns, including the header line, is correct

- The column expected to contain time information does not contain other types of information.

3.3 Analyzing the Table Structure
Before analysis with Process Discovery, use the following points to determine if the table structure is one that can be analyzed.

3.3.1 When Multiple Tables with the Same Schema Exist
Even when the specifications of the database only show one schema, there may actually be more than one type of CSV data corresponding
to it. This situation can occur in the following cases:

- Separate files are created for each period, though the usage is the same.

In Process Discovery, each file is processed as a different event type. If the files have only been separated by period, but in effect,
there is no need to separate them, they can easily be merged into one file and treated as one event type. Combine the CSV data before
extracting the event.

- The same schema is used for different types of information.

In this case, information in the file name itself might be missed when the CSV data is merged, and it may not be processed correctly.
In this case, it may be better to treat the CSV data as separate event types. Even if they are to be treated as separate events types, if
there are fields within the data that indicates the type, the CSV data can be merged and the fields can be used to have the data recognized
as a different type of event.

3.3.2 History Tables
In a history table that contains two or more event types in one table, more than one field that identifies the event type will exist. Confirm
which field identifies the event type.

3.3.3 Timestamp Format
A template to detect the timestamp is built into Process Discovery. The template can handle the following formats.

 
yyyy-MM-dd HH:mm:ss

yyyy/MM/dd HH:mm:ss

yyyy/M/d H:mm:ss

yyyyMMdd'T'HHmmss

yyyyMMddHHmmss

yyyy/MM/dd HH:mm

yyyy/M/d H:mm

yyyyMMddHHmm

millisec

yyyy/MM/dd

yyyy/M/d

yyyyMMdd

yyMMdd
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d/M/yyyy H:mm:ss

d/M/yyyy

yy/M/d

d/M/yy

ddMMMyyyy

yyyy+M+d

yy-M-d

d.M.yyyy

M/d/yyyy

M/d/yyyy H:mm:ss

yyyy-M-d'T'H:mm:ss

yyyy-MM-dd HH:mm:ss.SSS

yyyy/MM/dd HH:mm:ss.SSS

yyyyMMdd'T'HHmmss.SSS

yyyyMMddHHmmss.SSS

d/M/yyyy H:mm:ss.SSS

M/d/yyyy H:mm:ss.SSS

yyyy-M-d'T'H:mm:ss.SSS

HH:mm:ss

HHmmss

HHmm

H:mm:ss

H:mm:ss.SSS

HHmmss.SSS

3.3.4 Analyzing Event Keys
Find out whether the event key is composed of a single field (simple event key) or composed of multiple fields (composite event key).
Confirm whether the composite event key relates to other tables.

3.3.5 Defining Events by Generalizing Attributes
In some instances, the CSV data received from a customer may not contain file names or fields that can be interpreted as events. In this
type of situation, we can rely on the fact that Process Discovery is a tool designed to deduce tasks performed by people from the data it
is provided and produce a reliable event from the CSV data.

In the following example of CSV data, shipping statuses are known to be entered using numbers. "0" for order received, "1" for ready for
shipment, "2" for unshipped, and "3" for cancelled.

- 11 -



An event for shipping status "0" can, therefore, be defined by combining field values, as shown below. This means that an event can be
defined, which is easily recognizable as a task performed by a person.
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Chapter 4 Business Process Analysis and Interpretation
This chapter explains how to analyze business processes, using Process Discovery, to identify irregularities that indicate inefficient
processes. Timely detection of such weak processes requires prompt corrective action, which results in effective business processes
characteristic of a productive business environment.

4.1 Checking Correctness of Data
Business data must be correctly processed before it can be analyzed using the Process Discovery - Process Analyzer. Of course, the ideal
scenario would be to enter the correct parameters in the Process Generator and generate the correct process. However, this is not always
possible because the required information may not be available or, simply, due to mistakes. It is, therefore, recommended to perform
certain checks before beginning the analysis. This ensures the results are closer to real-time expectation, reduces any rework, and saves
both time and effort.

Look out for the following scenarios to ensure the source data is correct for use by the Process Analyzer:

- Routes are independent of the main process

There may be cases where branches occur from INITIAL_STATE and flow to FINAL_STATE without crossing over. This indicates
that there is no correlation between the event keys of these processes. Ensure the processes do not have correlations from a business
perspective. If, however, it seems that correlations may exist, look for the Correlative Event Key.

- Uncorrelated events are mixed

Possible causes:

- Event keys have been given associations even though they should never have been associated

- Event keys that are different are considered to be the same

- A Composite Event Key has been mistakenly defined as a Plain Event Key

Refer to correlations in the Correlation Candidates Selection tab of the Process Generator, and check whether it is a Composite
Event Key.

- Order of events is not as expected

Possible causes:

- Time information may not be synchronized properly if the CSV data has been taken from different systems

- Data from systems based on hours, minutes, and seconds could be mixed with data from systems based only on the date

- Batch processes may have been included

When batch processes are included, all the processes in a batch have exactly the same time information, or at least, it is very close.
Process Discovery works on the principle that the order indicated by the time is the order in which processes are performed. This
means that the order shown for events in batch processes may differ real-time.

- Time information may have been updated by the system

Some systems overwrite time information when some repetition occurs.

4.2 Business Analysis

4.2.1 Testing Predictions about Processes
This section explains how to test business processes and determine if the predefined process specified in the design document matches its
real-time implementation. There are three key objectives for testing processes:

- To understand the current process

- Identify the types of processes applicable in a business scenario and distinguish between them

- Processes that occur frequently conform to the predefined business rules and are referred to as Typical Processes
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- Low-frequency processes or processes that are infrequent are more likely to have inconsistencies with the business rules and are
referred to as Exceptional Processes

- Find out whether there are discrepancies between the design and real-time implementation of processes

Some of the primary reasons for process discrepancies include:

- Outdated design documents not up-to-date with the system or changes in procedures

- Operational issues, such as usability of the system, may cause real-time processes to operate differently than their expected,
predefined behavior

- Underlying data, used for generating processes in Process Discovery, has not been collected correctly (for example, not enough
data or mistakes in associations)

 

 Note

Process Discovery uses data obtained from customers. It is, therefore, not always possible to obtain data for an extensive period (a year
or more) due to the substantial work involved in data collection. This means that the collected data may not include data for certain seasons
or special events (for example, end-of-year events). So, even if a process is specified in design documents, it cannot always be replicated
using Process Discovery.

Refer to the following procedures for testing business processes.

 
Comparison with Typical Processes

From Process Analyzer, select the Process Analysis tab to display the process diagram.

Refer to the Process Filter area of the Control Panel. By default, the slider is set to 100%—the maximum frequency of processes. This
means that all processes are ordered by the occurrence rate of the route, with the highest number of occurrences first and showing up to
100%. Move the slider up to display processes that occur fewer times, making the process diagram more complex.

Additionally, click Show Typical Process to display the Typical Process for your business. Doing this automatically sets the slider to a
specific position. The process diagram displayed, at this point, depicts the Typical Process—process that conforms to the predefined business
rules. Check the flow of events in the process diagram for any irregularities.

 
Comparison with predefined processes

If process diagrams have been created as part of the design, compare these with the predefined Process Discovery diagram.

Note that the granularity of the two diagrams may differ. While in Process Discovery, an event is the data entering a business system, a
design may describe the instructions given to end users or show the flow of data. This means the two process diagrams will depict different
aspects of the business process and the amount of detail they go into will also differ.

 

 Note

Additionally, the order of events may differ between the processes generated using Process Discovery and the ones described in the design
documents. Also, check for differences in the time information, if any.

4.2.2 Validating Conformation of Processes to Business Rules
This section explains how to test if processes do not follow business rules.

 
High-level analysis of Exceptional Processes

Exceptional Processes, that occur infrequently, often take steps that are not followed in most processes.

Using Process Analyzer, you can display Exceptional Processes with Typical Processes and compare them to identify Exceptional Process
activities that do not map with the Typical Process. These are the activities that do not conform to business rules.
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Filter Exceptional Processes that do not meet specific business rules

If you are aware of specific business rules, Process Analyzer allows you to filter processes that do not conform to those rules.

Consider a rule that requires an event called "Deliberation" to be triggered before the event "Approval". We can specify this rule in the
Process Analyzer and filter specific processes that do not follow this rule.

The following procedure describes how to filter Exceptional Processes using the Process Analyzer.

1. From the Process Analyzer, select the Exceptional Route Analysis tab.

2. Click Sort to display the Route Sorting dialog box.

3. Edit the available options to specify your filter criteria.

a. Select the List Routes that do not meet the condition below first.

b. Select an event from the Target Event list.

c. Select an event from the Target Event Precondition box. This event will precede the event selected in the previous step.
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4. Click Apply.

Processes that do not meet the specified criteria are displayed in the Exceptional Route List.

Refer to "8.5.1.1 Route Sorting" for details.

 
Filter Exceptional Processes that show specific actions

For actions that do not conform to business rules, Process Analyzer allows you to filter processes that use these actions.

The following procedure explains how to filter processes with specific actions using the Process Analyzer.

1. From the Process Analyzer, select the Exceptional Route Analysis tab.

2. Click Sort to display the Route Sorting dialog box.

3. Edit the available options to provide your filter criteria.

a. Select List Routes containing these actions first.

b. Select appropriate values for the Action Source and Action Destination.

4. Click Apply.

Processes that follow the specified actions are displayed in the Exceptional Route List.

Refer to "8.5.1.1 Route Sorting" for details.

4.2.3 Discovering Inefficiencies in Processes
This section explains how to discover inefficiencies in business processes.

Use the following guidelines to derive process inefficiencies using Process Analyzer:

- Search for repetitious processes

- Search for loopback processes

- Search for bottlenecks that increase operational time

 
Repetitious processes

Inefficiencies are often associated with processes that are performed repeatedly.

There are, of course, cases where processes must be repeated, and so, this is not the main criteria for identifying erroneous processes.
Similarly, there are cases that appear to be repetitious but actually involve issuing of very similar details. Therefore, before determining
if the repetitious nature of a process is actually a problem, consider the peculiarities of the system.
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To view the repetition frequency of a process, refer to the Repeats header in the Route List or Exceptional Route List for Typical Process
and Exceptional Processes, respectively. Additionally, select the header to display the processes in the ascending or descending order.

 
Loopback Processes

Inefficiencies can also be discovered where a process that has already been successfully executed is performed again. Such processes are
referred to as Loopback Processes. These processes, however, do not always indicate inefficiencies. Use your discretion to interpret
loopback processes as erroneous.
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To view the number of loopbacks for a process, refer to the Loopbacks header in the Route List or Exceptional Route List for Typical
Process and Exceptional Processes, respectively. Additionally, select the header to display the processes in the ascending or descending
order.

 
Bottlenecks that increase operational time

Adjust the Control Panel settings to display the average action time and the standard deviation in a process diagram. Use the Show Action
Time in options to enable the arrows - indicative of actions in a process - to display the average action time and standard deviation.

Review the process diagram to identify actions that consume substantial average time or have significant standard deviation. Further,
where the standard deviation is high, the time differences are also considerable. These are the areas in a process that need to be improvised
for efficiency.
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4.2.4 Using Properties to Compare Processes
You can use process properties to compare how different departments employ their processes, or perhaps, how processes differ in varied
production scenarios for different products. This type of comparison can reveal the best practices observed by a particular process or weak
areas that require improvement.

 
Filtering processes by property

By creating process diagrams for each department, you can see how processes differ across departments.

If the business data includes a unique property for a department, Process Analyzer enables you to filter specific processes that match the
given property. This enables you to view a customized process diagram that shows distinct workflow pattern for that department. The
same can be done for other departments.

Additionally, because different departments deal with different products and customers, there are bound to be differences in the way each
department employs their business process. By comparing the process diagrams for each department, these differences become apparent.

The following procedure describes how to generate process diagrams that contain a specific property.

1. From the Process Analyzer, click Tools > Analyze > Filter. Doing this displays the Define Filter Criteria dialog box that provides
various options for defining a process filter.

2. Click Add > Property.
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3. From the Property Name list, select the property you want to filter.

4. Specify additional filter criteria using Condition 1 and Condition 2.

5. Click Apply to execute the filter.

Process diagrams that match the specified property are displayed.

Refer to "8.4.4 Set Filter Criteria" for details.

 
Filtering action time distribution by property

Process Analyzer allows you to compare the action times of processes filtered by a unique property.

The following procedure explains how to display the distribution of time in actions for each property.

1. In a process diagram, right-click an action and Show Action Time Distribution.

2. In the Action Time Distribution dialog box, select the properties to be compared.

When properties are selected for comparison, the action time statistics for the properties are shown in the Action Time list. Histograms
showing the distribution for each property can also be shown or hidden.

Refer to "8.4.3 Show Action Time Distribution" for details.

4.2.5 Assessing Changes in Processes Over Time
You can monitor changes in a business process by making regular observations over a period of time. If the expected behavior of a process
is known, it is possible to assess the deviation of a process from its ideal state.

Process Discovery allows you to compare process diagrams for a specific time period or monitor Key Performance Indicator (KPI) values
in a chronological order.

 
Differences in process diagrams by period

Some deviations are obvious and can be determined by simply looking at the differences in business processes generated for a specific
time period. If a years worth of data is available, Process Analyzer provides you the flexibility to perform custom analysis on it. For
example, you may generate processes for quarterly periods and examine the differences.

The following procedure explains how to display processes for a specific period.

1. From the Process Analyzer home page, click Tools > Analyze > Filter. Doing this displays the Define Criteria dialog box that
provides various options for defining a process filter.

2. Click Add > Period to display the Period Filter Criteria area.

3. Select Start Date, and specify the start date for the process.

4. Select End Date, and specify the end date for the process.

5. Click Apply to execute the filter.

A process diagram with processes for the specified time period is displayed.

Refer to "8.4.4 Set Filter Criteria" for details.

4.2.6 Assessing the Extent of Standardization
For some production tasks, it is important that procedures are performed exactly the same way, without exception. Hints for improvement
can be gained by finding out the extent of standardization in such cases, with the aim to have the business processes use the same pattern
whatever the case.

You can assess the extent of standardization in business processes by:

- Assessing the fluctuations in action time

- Understanding the concentration of routes
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Assessing fluctuations in action time

There may be a problem if the average time taken for an action is too long, but there is also a high likelihood of a problem if the action
time fluctuates.

If the fluctuations of a particular action time are significant, the possible cause may be:

- Details of processes differ, and so, the action times are different

- Details of processes are the same, but the properties are different so the action times are different

- Details of processes extracted using Process Analyzer are the same, but there are certain processes in the paths between nodes that
cannot be extracted using this tool; also, the differences in the times taken to perform these processes cause differences in the action
times

To view the fluctuations in action time using the Process Analyzer, click View > Action > Time > Standard Deviation. Alternatively,
you may select the Standard Deviation check box from the Control Panel.

This shows the differences in standard deviation - higher the values, greater the time differences. The standard deviation for actions that
occur only once is shown as "0.0".

 
Understanding the concentration of routes

A process is considered to be more standardized the more it concentrates on one particular route. If a particular process is not an obvious
candidate, however, the following situations may be occurring:

- Steps in the processes are different (few common steps)

- Tasks that could have been treated as the same, but with different properties, were made into different event types when the process
was generated

- There are parallel processes which would be the same route if described in parallel, but because the order of execution is different,
they appear to be different routes

Pareto charts in the Process Analyzer graphically represent the concentration of routes.

The horizontal axis displays the different processes represented as bars, while the vertical axis displays the frequency of occurrence of
processes. The height of a bar is indicative of the frequency of the process it represents. The Pareto chart lists the processes in a descending
order with the process that has the highest frequency listed first.

The line graph shows the cumulative total of occurrences of routes. For example, if the route occurring most occurs 50% of the time, then
the next most frequent route occurs 10% of the time, the line graph will start at 50%, then grow to 60%, thus increasing to finish at 100%.

Therefore, the Pareto chart will climb swiftly if the procedure consists of a few Typical Processes. If the climb is smooth, on the other
hand, a dominant route does not exist and rather evenly distributed.

Also, if the total number of processes is the same and the number of routes is low, this means there are not many variations and
standardization has progressed.

To display the Pareto chart, click Tools > Analyze > Pareto Chart.

Refer to "8.8 Pareto Chart" for details.

4.2.7 Cost Simulation
Using Process Analyzer, you can add sample costs to events and actions in a process and estimate the total cost for operating the entire
process. For this, click Tools > Cost Settings to display the Cost Settings dialog box where you can specify the cost for events or actions
of a process.

Refer to "8.4.5 Cost Settings" for details.
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Chapter 5 Process Generator Overview

5.1 Window Configuration

5.2 Getting Started
 

Preparations

Set up the Process Discovery database before using the Process Generator.

Refer to Chapter 4, "Installing and Setting Up Analytics Server" in the Interstage Business Process Manager Analytics V12.0 Installation
Guide for details.

 
Creating users and assigning groups

Create users, and assign them to the Process Generator User group to log into the Analytics Console.

Refer to the Management Console Guide for details.
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Starting the Analytics Console

Specify the following URL to display the Analytics Console.

http://[ServerName]:[PortNumber]/ibpmm/

The Process Generator tab appears after you login.

5.3 Sample Process Generator Scenarios
Use of the Process Generator depends on the type of CSV file input.

This section explains how to use the tool for different types of CSV files.

5.3.1 Data Type 1
Business logs are a common data format fed into the Process Generator.

- 1 CSV file is used

- There are IDs allocated per process with slip numbers

- There is one "Time" field for the timestamp

- The "Process name" field is indicative of the actual process

Example CSV file:

 
Request ID Event Name Person Name Time

ID001 Accept Goto 2006/12/11 07:12:13

ID002 Accept Tanaka 2006/12/13 09:21:58

ID001 Publish Estimation Goto 2006/12/14 11:52:41

ID001 Accept Goto 2006/12/16 19:17:44

ID002 Publish Estimation Tanaka 2006/12/16 21:48:38

ID003 Accept Tanaka 2006/12/19 14:55:36

ID001 Design Goto 2006/12/19 15:02:41

ID001 Confirmation Goto 2006/12/21 17:13:22

ID002 Cancel Tanaka 2006/12/23 16:24:23

ID003 Publish Estimation Tanaka 2006/12/23 17:00:11

ID003 Accept Tanaka 2006/12/25 20:26:08

ID001 Delivery Goto 2007/01/08 10:34:38
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Correlation Candidates Selection

Refer to "6.4 Selecting Correlation Candidates" for details.

 
Extraction Items Selection

With this type of data, process with the same slip numbers are considered to be the same and processes are generated according to the
order in which the process name appears (starting from the earliest time).

Taking slip number ID001 as an example, the following process is generated.

(Receipt.time) -> (Estimate.time) -> (Order.time) -> (Design.time) -> (Confirmation.time) -> 

(Delivery.time)

There is one Event Name Item and one timestamp for each event with this type of data, so the event name is the combination of these two.

Refer to "6.5 Extraction Item Settings" for details.

5.3.2 Data Type 2
Another data format fed into the Process Generator is the business event log.

- 1 CSV file is used

- There are IDs allocated per process with slip numbers

- There are eight fields for the timestamp and each of these corresponds to a particular process

Example CSV file:

 

Request ID Person Name Accept time
Publish

Estimation time
Receive

Order time
Design time

Confirmation
time

ID001 Goto 2006/12/11 2006/12/14 2006/12/16 2006/12/19 2006/12/21

ID002 Tanaka 2006/12/13 2006/12/16

ID003 Tanaka 2006/12/19 2006/12/23 2006/12/25 2007/01/10 2007/01/17

ID004 Suzuki 2007/01/10 2007/01/12 2007/01/19 2007/01/28 2007/02/05

ID005 Goto 2007/01/15 2007/01/20 2007/01/25 2007/02/02 2007/02/12

ID006 Saito 2007/01/16

ID003 Tanaka 2007/01/21 2007/01/24

ID007 Suzuki 2007/01/22 2007/02/01 2007/02/04 2007/02/05 2007/02/08
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Request ID Person Name Accept time
Publish

Estimation time
Receive

Order time
Design time

Confirmation
time

ID007 Suzuki 2007/02/18

(continuing above)

 
Delivery time Reject time Cancel time

2007/01/08

2006/12/23

2007/01/17

2007/02/10

2007/02/15

2007/01/17

2007/01/26

2007/02/13 2007/02/16

2007/02/21

 
Correlation Candidates Selection

Refer to "6.4 Selecting Correlation Candidates" for details.

 
Extraction Items Selection

Taking slip number ID001 as an example, the following process is generated.

(Accept time) -> (Publish Estimate time) -> (Receive Order time) -> (Design time) -> (Confirmation 

time) -> (Delivery time)

The Event Name Item is not specified with this type of data, so the timestamp item name is used as the Event name.

See the Correlation Candidates Selection for details.

Refer to "6.5 Extraction Item Settings" for details.

5.3.3 Data Type 3
This example considers the data format of a business event log with the following specification:

- Eight CSV files are used
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- Each CSV file has a "Time" field for the timestamp

- IDs are different for the processes, depending on the CSV file

Example CSV file:

Cancel.csv
 

Request ID Order ID Person Name Time

ID002 2006/12/23 16:24:23

ID006 Saito 2007/01/17 11:19:20

ID008 J06 Saito 2007/02/10 11:26:13

Publish estimation.csv
 

Request ID Person Name Time

ID001 Goto 2006/12/14 11:52:41

ID002 Tanaka 2006/12/16 21:48:38

ID003 Tanaka 2006/12/23 17:00:11

ID004 Suzuki 2007/01/12 11:31:30

ID005 Goto 2007/01/20 08:45:19

ID007 Suzuki 2007/02/01 07:59:47

ID008 Saito 2007/02/05 11:48:02

ID008 Saito 2007/02/05 18:48:51

Reject.csv
 

Order ID Person Name Time

J02 Tanaka 2007/01/17 17:50:54

J05 Suzuki 2007/02/16 10:10:28

Receive order.csv
 

Request ID Order ID Person Name Time

ID001 J01 Goto 2006/12/16 19:17:44

ID003 J02 Tanaka 2006/12/25 20:26:08

ID004 J03 Suzuki 2007/01/19 19:39:38

ID005 J04 Goto 2007/01/25 12:36:48

ID007 J05 Suzuki 2007/02/04 15:01:48

ID008 J06 Saito 2007/02/09 08:10:29

Accept.csv
 

Request ID Person Name Time

ID001 Goto 2006/12/11 07:12:13

ID002 Tanaka 2006/12/13 09:21:58

ID003 Tanaka 2006/12/19 14:55:36

ID004 Suzuki 2007/01/10 09:06:02

ID005 Goto 2007/01/15 14:09:53

ID006 Saito 2007/01/16 15:30:47
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Request ID Person Name Time

ID007 Suzuki 2007/01/22 16:11:52

ID008 Saito 2007/01/24 11:48:12

Design.csv
 

Order ID Person Name Time

J01 Goto 2006/12/19 15:02:41

J02 Tanaka 2007/01/10 18:19:40

J02 Tanaka 2007/01/21 15:49:27

J03 Suzuki 2007/01/28 16:36:31

J04 Goto 2007/02/02 09:18:11

J05 Suzuki 2007/02/05 19:11:50

Confirmation.csv
 

Order ID Person Name Time

J01 Goto 2006/12/21 17:13:22

J02 Tanaka 2007/01/17 08:33:52

J02 Tanaka 2007/01/24 07:50:29

J03 Suzuki 2007/02/05 18:41:03

J05 Suzuki 2007/02/08 10:05:03

J04 Goto 2007/02/12 13:09:29

J05 Suzuki 2007/02/18 05:09:17

Delivery.csv
 

Order ID Person Name Time

J01 Goto 2007/01/08 10:34:38

J02 Tanaka 2007/01/26 14:23:18

J03 Suzuki 2007/02/10 09:41:26

J05 Suzuki 2007/02/13 09:16:35

J04 Goto 2007/02/15 18:27:59

J05 Suzuki 2007/02/21 21:13:44
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Correlation Candidates Selection

Refer to "6.4 Selecting Correlation Candidates" for details.

 
Extraction Items Selection

Taking slip number J01 as an example, the following process is generated.

(Accept.Time) -> (Publish estimation.Time) -> (Receive order.Time) -> (Design.Time) -> 

(Confirmation.Time) -> (Delivery.Time)

The Event Name Item is not specified with this type of data, and only one Timestamp Item is specified.

So, the event name is the combination of CSV file name and Timestamp Item.

Refer to "6.5 Extraction Item Settings" for details.
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Chapter 6 Process Generator Features
This chapter covers the Process Discovery - Process Generator features.

6.1 Process Generation Overview
Process Generation involves the following steps.

Select a model [Required]

Configure a CSV file, also referred to as a "model", for process data generation; refer to "6.2 Selecting Model" for details

Select composite items

Combine several fields of a CSV file, and create one new field, referred to as a "composite item"; refer to "6.3.1 Setting Composite
Items" for details

Profiling [Required]

Involves analysis of the characteristics of CSV fields, including capturing the time information; analysis results are later used for
different purposes, such as generating timestamps; refer to "6.3 Profiling" for details

Analyze correlations

Involves calculating similarities between the CSV fields, also referred to as "properties", in a source and destination CSV file; allows
event keys to be automatically set and to calculate correlation scores - a score that indicates the probability of correlation between the
source and destination CSV files

Use this process only when importing two or more CSV files; do not use when there is only one CSV file or if the event keys are
already known.

Select Correlation Candidates

Set the relationship between correlated properties for items that will be used as key properties in CSV files and when more than one
CSV file is input.

Refer to "6.4 Selecting Correlation Candidates" for details.

Select extraction items

Select the following items for each CSV file

Timestamp Items [Required]

Select the items you want to use for time.

Event Name Item

If there are items that express more than one event in one CSV file, select these items as Event Name Items; the CSV file will be
used if this is not selected

Property Item for Analysis

Select the properties o be used for analysis

Refer to "6.5 Extraction Item Settings" for details.

Generate Process Data [Required]

Generate processes using the selected correlation candidates and the timestamp items.

Refer to "6.6 Generating Process Data" for details.

6.2 Selecting Model
Process Discovery uses the term "model" to refer to the CSV file (or files) analyzed to generate the process data.

To begin generating the process data, login to the Analytics Console and select the Process Generator tab. Doing this displays a list of
models defined in Analytics. From the Model Type list, select either Business Event or IBPM Event to display a list of models. Select
a model to edit its configuration.
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- For business event models, the Process Generator displays the following options

 
GUI Option Description

Model Name Displays the name of the model

Condition Displays the current processing status of the model, such as "Process Data
Generated" or "Process Data Generating Failed"; refer to "Model status (Business
Events)" below for details

Last Modified Displays the date when the model was last updated

CSV Directory Displays the complete path of the directory that stores the CSV file

Update [button] Updates the window

Edit [button] Enables you to edit a model

Rename Model [button] Allows you to change the current name of the model; refer to "Renaming Models"
below for details

Create New Model [button] Enables you to create a new model of the business event type; refer to "Creating
New Models" below for details

Delete [button] Allows you to delete a model

Update CSV files [button] Update CSV files

This is available when model status is one of followings:

- Process Data Generated

- Process Data Generating Failed

- Process Data Updating Failed

 

 Note

Model, which is used for configuring KPI from the Process Analyzer, cannot be used Rename Model and Delete button, and, when operating
Edit, displaying Correlation Candidates Selection screen and Extraction Items Selection screen are only permitted.

- For IBPM Event models, the Process Generator displays the following options:

 
Item Description

Model series Displays the name of the model series

Project Name Displays name of the project to which the model belongs
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Item Description

Condition Displays the current processing status of the model, such as "Process Data
Generated" or "Process Data Generating Failed"; refer to "Model status (IBPM)"
for details

Last Modified Displays the date when the model was last updated

CSV Directory Displays the complete path of the directory that stores the CSV file

Update [button] Updates the window

Edit [button] Not available

Rename Model [button] Not available

Create New Model [button] Not available

Delete [button] Allows you to delete a model

 
Model status (Business Events)

Business Event-based models can have the following statuses.

- Initial

- Profiling

- Profiling Finished

- Correlation Candidates Selected

- Extraction Items Selected

- Process Data Generating

- Process Data Updating

- Process Data Generated

- Profiling Failed

- Process Data Generating Failed

- Process Data Updating Failed

 
Model status (IBPM Events)

IBPM Events-based models can have the following statuses.

- Process Data Generated

- Process Data Generating Failed

 
Display transition with model status

When executing Edit button, display is transited to following destination.

 
Model status Destination

Initial Profiling

Profiling

Profiling Finished Correlation Candidates Selection

Correlation Candidates Selected Extraction Items Selection

Extraction Items Selected Process Data Generation

Process Data Generating

Process Data Updating Profiling
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Model status Destination

Process Data Generated Process Data Generation

Profiling Failed

Process Data Generating Failed

Process Data Updating Failed

 
Locking for model operation

Model which is being operated by other user cannot be operated.

This locked status is released when returning to Model List after generating Process Data or clicking Model List on the column header.

A command is used for unlocking models forcibly.

Refer to the "Appendix B Commands" for details.

6.2.1 Creating New Models
From the Process Generator tab, click Create New Model to display the Create New Model dialog box. As the name suggests, this dialog
box provides options that allow you to create new models.

The Process Generator provides two options for uploading CSV files - from the server or client. Additionally, you can upload multiple
CSV files simultaneously.

 
GUI Option Description

Model Name Type a model name; Do not include illegal characters (\ / | , = : " * ? < > &) or spaces in
the name

CSV Directory Specify the directory on the server that stores the CSV file

Upload Files Allows you to upload CSV files or zip files included multiple CSV files from the client;
selecting this option displays additional options for uploading files

Browse [button] Allows you to browse to a CSV file or zip files included multiple CSV files on the client,
and select it for upload

Upload [button] Starts the upload

Apply [button] Creates the model, and closes the dialog box

The new model appears in the Model List on the Process Generator tab

Cancel [button] Closes the dialog box without creating a model

 

 Note

- Maximum size of CSV file or zip file to be uploaded is 100 megabytes.

- A zip file can be included up to 1000 CSV files.

- A zip file can be included up to 3 layer levels for a directory.
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6.2.2 Renaming Models
The Process Generator allows you to change models names according to your requirement. For this, click Rename Model from the Process
Generator tab. Doing this displays the Rename Model dialog box that provides the following options to change the model name.

 
GUI Option Description

Model Name Displays the current model name

New Model Name Type the new model name; Do not include illegal characters (\ / | , = : " * ? < > &) or spaces
in the name

Apply [button] Confirms the new model name, and closes the dialog box

Cancel [button] Closes the dialog box without changing the model name

6.3 Profiling
From the Process Generator tab, select a model and click Edit to display the model’s configuration. Select the Profiling tab to display
the profiling configuration options for the model. Using these options, you can set composite items, perform profiling, and analyze
correlations.

 
GUI Option Description

Analyze Correlations Select this check box to automatically perform correlation analysis

Do not select if the correlations between CSV files are already known and correlation
analysis is to be performed manually

Progress Displays the progress of the profiling

As profiling continues, the indicator moves from 0% to 100% where 100% indicates that
profiling has finished successfully; the indicator returns to 0% if profiling fails

Set Composite Properties Enables you to set composite items; refer to "6.3.1 Setting Composite Items" below for
details

Start Profiling [button] Select this button to begin profiling; doing this changes the button to Cancel Profiling that
allows you to terminate profiling, if required

When profiling completes, the button changes to Restart Profiling
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GUI Option Description

Profiling needs to be performed again if you have changed any composite item settings

6.3.1 Setting Composite Items
The Process Generator allows you to combine several fields in a CSV file to create one new field referred to as a "composite item". For
example, you may combine the Day, Month, and Year fields to generate the Date field, which will contain a value that is a resultant of all
the three fields. Here, "Date" is a composite item.

From the Profiling tab, click Set Composite Properties to display the following options that enable you to configure composite item
properties.

 
GUI Option Description

(check box) Select a composite property you want to edit or delete

Select only one property for editing

Select one or more property when deleting

Composite Properties Displays the composite properties

Item Name Displays the item name

CSV File Displays the name of the CSV file that the composite item refers to

Edit [button] Allows you to edit the configuration of an existing composite item; Refer to "Editing
composite items" for details

Create [button] Allows you to create new composite item properties

Select this button to display the Set Composite Properties dialog box

Refer to "Creating composite item properties" below for details

Delete [button] Allows you to delete a composite item
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Creating composite item properties

 
GUI Option Description

CSV File Name Displays CSV files included this model

Composite Property Name Type the composite property name; Do not include illegal characters (, | " ' < > &) or spaces
in the name

Config [button] Configures selected CSV files and composite property name

Selected Property Name Displays items that are included in the selected CSV file

Add [button] Allows you to add the selected item

Item Name List Displays added items

Delete [button] Deletes items that are checked in the list

Apply [button] Creates the Composite Property, and closes the dialog box

Cancel [button] Closes the dialog box without changing the model name

The following procedure describes how to create new composite item properties.

1. From the Set Composite Properties area (on the Profiling tab), click Create to display the Set Composite Properties dialog box.

2. From the CSV File Name list, select the CSV file that contains the fields to be added as composite items.

3. In the Composite Property Name box, type a meaningful name for the composite property to be created. Do not include illegal
characters (, | " ' < > &) and spaces in the name.

4. Click Config to confirm the selected CSV file and composite item property name.

5. From the Selected Property Name list, select the CSV fields or composite items to be included in the composite property.

6. Click Add to add the selected CSV fields.

7. Repeat step 5-6 to add multiple CSV fields.

- 35 -



8. Refer to the list of CSV fields to ensure you have added appropriate composite items.

9. Click Apply to create the composite property.

 
Editing composite items

The content of already set composite items is displayed.

You can edit the names and change the composite item properties. (You cannot change the CSV file names.)

6.4 Selecting Correlation Candidates
In the Correlation Candidates Selection, event key each CSV file can be selected. Moreover, correlations between CSV files are configured
when multiple CSV files are used.

 

 Note

It is crucial to select the correct event keys. You can use the Process Generator to assess the importance of data and whether it can be used
as a key, but its deductions are not always correct. Use your discretion to identify event keys.

 
Event Key, Correlation Source, Correlation Destination

Process Discovery applies the following rules to identify correlations in a CSV file determined to be an RDB table.

- Each column or field is a considered a property.

- There is only one property that can be used as an event key.

- When the values of properties in two different CSV files are the same, a correlation is considered to be established between the two
files.

Here is an example to illustrate the above points. Consider two CSV files - an "Orders" table and a "Quotes" table. The "Orders" table
contains the Order_No and Quote_No fields, and the "Quotes" table contains the Quotation_No field. Considering the Process Discovery
rules, these fields are referred to as "properties".
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If the Quote_No property, for an order HA-0050, from the "Orders" table has the same value, MI-0111, as the Quotation_No property of
the "Quotes" table, a correlation is considered to be established between the records HA-0050 and MI-0111 of the "Orders" and "Quotes"
tables, respectively.

If many such correlations exist between the records of two tables, the tables are correlated.

6.4.1 Selecting Correlation Candidates in Correlation Charts
From the Process Generator tab, select a model and click Edit to display the model’s configuration. Select the Correlation Candidates
Selection tab to display the correlation between different CSV files. Additionally, the Correlation Candidates Selection tab provides
the following options to generate correlations directly by selecting event keys and correlation candidate keys.
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GUI Option Description

Submit Candidates [button] Submits the event key and correlation candidate selections

Reset [button] Resets the event key and correlation candidate selections

If correlation candidates have not been submitted, the Correlation Candidates Selection
window is restored to the state after profiling.

If correlation candidates have been submitted, the Correlation Candidates Selection
window is restored to the state it was in when the last correlation candidate was submitted.

Delete All Correlations [button] Deletes all correlations

 

 Note

When correlation candidate selections are dynamically changed, profiling is automatically executed.

Followings are details of operations.

 
Selection and Deletion of Event Key, Correlation Candidate Key
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Selection of Event Key

Select an event key from list box. "Overlap" is also displayed in this list. (See the later for explanation of "overlap".)

Selection and Deletion of Correlation Candidate Key

Select a correlation candidate key from list box.

After selecting, another list box for selecting a correlation candidate key is shown up.

In case deleting a correlation candidate key, click the X button. And then, correlation setting is deleted as well.

 
Creation and Deletion of Correlation

Group Correlation

When overlapping each event key, group correlation is configured.

These tables are regarded as one table.
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Common Correlation

When overlapping a correlation candidate key on an event key of another table, common correlation is configured.

Deletion of Group Correlation

When left-clicking in the frame of group correlation, list of deletable group correlations are shown up.

When deleting all group correlations, Remove All Group Correlations can be used.
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Deletion of Common Correlation

When left-clicking in the edge of arrow, list of deletable common correlations are shown up.

When deleting all common correlations, (correlation source) > All Correlation can be used.

6.4.2 Selecting Correlation Candidates - Detailed Settings
This section describes additional settings to be configured when selecting correlation candidates.

From the Correlation Candidates Selection tab, select the CSV file icon to display the Select Correlation Candidates dialog box. This
dialog box provides options to configure the event key or set correlations between CSV files, if more than one is loaded.

 
Selecting correlations from the list of correlation candidates

This list shows only those candidates found to have possible correlation during profiling.

Make new correlations if you need to set correlations that do not appear in this list.
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This table describes the items in the Select Correlation Candidates dialog box.

 
GUI Options Description

(check box for each correlation
candidate listed)

Select to set correlations.

If correlations have already been set, this will be selected and you will not be able to change it.

Score Indicates the probability of correlation between CSV files.

Is a numeric value of up to four decimal places.

Higher the value, greater is the probability of correlation.

Is calculated using data values found in the properties of the Correlation Source and Correlation
Destination.

Correlation Destination

CSV File Displays the name of the CSV file designated as the correlation destination

Property Displays properties of the CSV file designated as the correlation destination

Correlation Source

CSV File Displays the name of the CSV file designated as the correlation source

Property Displays properties of the CSV file designated as the correlation source

Details Displays a detailed account of source and destination correlations in a separate window

Create New Correlation
[button]

Launches a wizard for creating new correlations; refer to "Creating new correlations" below
for details

Apply [button] Submits the event key and correlation candidate selections, and closes the dialog box

Cancel [button] Cancels the event key and correlation candidate selections, and closes the dialog box

 
Creating new correlations

From the Correlation Candidate List tab (of the Select Correlation Candidates dialog box), click Create New Correlation to launch
the wizard that creates new correlations.

This table lists the key options common across all the wizard screens.
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GUI options Description

Back [button] Select this button to return to the previous screen

Next [button] Applies the settings specified in the current screen and moves to the next screen

Cancel [button] Terminates the process of creating new correlations and closes the wizard

The following procedure explains how to create new correlations using the Wizard:

1. Select Correlation Direction screen

This screen enables you to specify the direction of correlation between CSV file items.

Select either Correlations from this CSV File or Correlations to this CSV File, and click Next.

2. Select CSV File screen

Select the CSV file to be used as the correlation source or destination, and click Next.

3. Select Correlation Candidate screen

Select the items to be correlated, and click Next.

This describes the various options in the Select Correlation Candidates dialog box.

 
GUI Option Description

Filter Type parts of characters to narrow down the items displayed in the correlation
candidate list

Score Indicates the probability of correlation between CSV files.

Is a numeric value up to four decimal places.

Higher the value, greater is the probability of correlation.

Is calculated using data values found in the properties of the Correlation Source and
Correlation Destination.
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GUI Option Description

Correlation Destination

CSV File Displays the name of the CSV file designated as the correlation destination

Property Displays properties of the CSV file designated as the correlation destination

Correlation Source

CSV File Displays the name of the CSV file designated as the correlation source

Property Displays properties of the CSV files designated as the Correlation Source or
Correlation Destination

Change Property of
Correlation Destination

[button]

Allows you to change the properties to be used as event keys for the Correlation
Destination.

Properties have already been set by the assumptions made about event keys in the
destination, so use this option only when necessary.

Select the event key candidate, and click Next.

If replace of event key for correlation destination is required, Change Property of Correlation Destination can be used.

In this screen, select the key candidate and click Next.

This table describes the items in the Create New Correlation dialog box.

 
GUI Option Description

Filter Type parts of characters to narrow down the items displayed in the correlation
candidate list

Overlap Displays the overlap between keys after correlations have been analyzed.

Specified in numeric value, a higher value denotes greater overlap, while '0'
indicates no overlap.
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GUI Option Description

Up to four decimal places are shown.

Key Candidate Displays the name of properties included CSV file

4. Correlation Confirmation screen

Displays all the settings specified in the previous screens of the Wizard, including the Converse Coverage rate or the rate of
correlation between properties of the Correlation Source and Correlation Destination.

5. Click Completion to create new correlations.

 
Specifying event keys

From the Select Correlation Candidates dialog box, select the Key Item Selection tab to select event keys.

This table describes the items in the Key Item Selection tab.

 
GUI Option Description

Filter Type parts of characters to narrow down the items displayed in the Correlation Candidate
List.

Overlap Displays the overlap between keys after correlations have been analyzed.

Specified in numeric value, a higher value denotes greater overlap, while '0' indicates no
overlap.

Up to four decimal places are shown.

Key Candidate Displays properties of the CSV file

Apply [button] Submits the event key selection, and closes the dialog box

Cancel [button] Cancels the event key selection, and closes the dialog box

 
Deleting correlations

From the Select Correlation Candidates dialog box, select the Correlations Removal tab to delete correlations you have configured.
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This table describes the items in the Correlation Removal tab.

 
GUI Option Description

Filter Type parts of characters to narrow down the items displayed in the Correlation Candidate
List

(checkbox for each correlation
listed)

Select the check box for the correlation you want to delete

Score Indicates the probability of correlation between properties of the CSV files.

Is a numeric value of up to four decimal places.

Higher the value, greater is the probability of correlation.

Is calculated using data values found in the properties of the Correlation Source and
Correlation Destination.

Relation Type Displays "Common" or "Group"

- Common - Indicates correlations exists between event keys and correlative properties
(correlation candidate keys)

- Group - Indicates correlations between event keys

Self Property Displays properties of the selected CSV file

Direction Right-pointing arrow indicates that the self property is the Correlation Source.

Left-pointing arrow indicates that the self property is the Correlation Destination.

Property Displays the source or destination property name

CSV File Displays the source or destination CSV filename

Select All Group Correlations
[button]

Selects all group correlations

Apply [button] Deletes the correlations, and closes the dialog box

Cancel [button] Closes the dialog box without deleting correlations
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6.5 Extraction Item Settings
From the Process Generator tab, select a model and click Edit to display the model’s configuration. Select the Extraction Items
Selection tab to determine how events are demarcated and the items to be used for analysis.

 
Demarcating events

Process Discovery uses a combination of the Event Name Item and Timestamp Item to demarcate events.

Event names take the following format:

"Value of Event Name Item"."Timestamp Item name"

The order in which an event occurs is determined by the Timestamp Item, so this must be specified. You can specify more than one
Timestamp Item. In this case, the Timestamp Item names are appended to the Event Name Item value.

Specify the Event Name Item when it is to be used as a part of the event name. If you do not specify the Event Name Item, the CSV
filename is used as part of the event name. If you specify multiple Event Name Items, they are concatenated.

 
Properties used for analysis

The processes you have generated can be analyzed in the following ways using the properties as starting points.

- Show Property Distribution

See the "8.4.2 Show Property Distribution" for details.

- Show Action Time Distribution

See the "8.4.3 Show Action Time Distribution" for details.

Specify the properties you want to use for analysis.

The following table describes the various options provided by the Extraction Items Selection tab.

 
GUI Option Description

CSV File Name Displays the name of the CSV file

Event Name Item Displays the Event Name Item; items are separated by commas if there are more than one

Timestamp Item Displays the Timestamp Item; items are separated by commas if there are more than one

Property Item for Analysis Displays the properties used for analysis; items are separated by commas if there are more
than one
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GUI Option Description

Timestamp Item and Event Name
Item [button]

Allows you to select Timestamp Item and Event Name Item; refer to "6.5.2 Selecting
Timestamp Item and Event Name Item” below for details

Property Item for Analysis and
Timestamp Type [button]

Allows you to select the Property Item for Analysis and Timestamp Type; refer to “6.5.1
Selecting Property Item for Analysis and Timestamp Type” below for details

Apply [button] Submits the selected extraction items

6.5.1 Selecting Property Item for Analysis and Timestamp Type
From the Extraction Items Selection tab, select a CSV file and click Edit to display the Edit Extraction Items dialog box. This dialog
provides options to select the properties to be used for analysis, including the timestamp type. Refer to the following table for a brief
description of these options.

 
GUI Option Description

Item Name Displays the composite items in the selected CSV file

For Analysis Select this check box to use the property for analysis

Timestamp Type Select the timestamp type.

When profiling is performed, the automatically detected timestamp types are selected;
change the timestamp type if it differs from the actual type.

Timestamp Score Indicates the likelihood of timestamp type; the closer the score is to 1, the more likely the
assumption

Apply [button] Submits the selection, and closes the dialog box

Cancel [button] Cancels the selection, and closes the dialog box

 

 Note

The system load increases in proportion to the increase in the size of CSV files and the total number of property items for analysis.

It is recommended that up to 10 property items be specified for analysis.

If you need to set more than 10 property items, take into consideration the total size of CSV files.
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6.5.2 Selecting Timestamp Item and Event Name Item
From the Extraction Items Selection tab, select a CSV file and click Select to display the Select Extraction Items dialog box. This dialog
box provides options to select the Timestamp Items and Event Name Items. Refer to the following table for a brief description of these
options.

 
GUI Option Description

Item List Displays the items in the selected CSV file

Show Overlap Select this check box to show the overlap of the items displayed in the Item List

Timestamp Items Displays the added timestamp items

Add > [button] Adds the item in the CSV file as a Timestamp Item

Join > [button] Enables you to add all items, displayed in the Item List, collectively as a single timestamp
item in a joined CSV file; select more than one CSV file item by using the Ctrl key

< Delete [button] Removes a Timestamp Item

Event Name Item Displays the added event name items

Add > [button] Adds the item in the CSV file as an Event Name Item

< Delete [button] Removes an Event Name Item

Apply [button] Submits the selection, and closes the dialog box

Cancel [button] Cancels the selection, and closes the dialog box
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6.6 Generating Process Data
From the Process Generator tab, select a model and click Edit to display the model’s configuration. Select the Process Data
Generation tab to generate process data from CSV files.

The following table lists the various options provided by the Process Data Generation tab.

 
GUI Option Description

CSV Directory Displays the complete path of the directory that stores the CSV file

Edit [button] Allows you to choose another CSV directory instead of the default.

Select this button to display the Edit CSV Directory dialog box.

Business Calendar Allows you to specify the business calendar to be used when calculating the action times;
a business calendar is not used for calculation if you specify nothing; refer to "6.7
Business Calendars" for details.

Event Repetition Select any of the given options - Treat all distinct, Ignore repetitions of more than twice,
or Ignore all repetitions - to specify how to treat event repetitions; refer to "Event
repetition" below for details

Progress Displays the progress of process generation

Message Displays messages; up to 50 of the most recent messages are displayed

Download Message... [button] Downloads messages if messages are output when executing process data generation.

If process data generation is executed again, former messages are deleted.

Update Process Data Properties
[button]

Adds properties to the process data that you have already generated.

Is valid when the properties to be used for analysis have been changed for process data
that has been generated.

Button label changes to Cancel Update Process Data Properties; enabling you to
terminate an update.

Add Process Data [button] Adds process data to existing process data;

Is available when a process has already been generated; refer to "Adding process data"
below for information on adding process data

Generate New Process Data [button] Allows you to create new process data.
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GUI Option Description

If process data already exists, data will be deleted and replaced by new process data.

Button label changes to Abort Generate New Process Data, enabling you to terminate
the process.

This table lists the options available in the Edit CSV Directory dialog box.

 
Item Description

Add Directory Specify the directory on the server where the CSV file is stored

Add [button] Adds the specified directory

Base Directory Displays the directory used to store the CSV file determined when the model was
generated

Added Directory Displays the directory you added

Apply [button] Submits the edits to the CSV directory, and closes the dialog box

Cancel [button] Cancels the edits to the CSV directory, and closes the dialog box

 

 Note

After aborting the process data generation, status of model is changed to “Process Data Generating”.

After aborting the process data properties update, status of model is changed to “Process Data Updating”.

If these are operated again, processing starts from the beginning.

 

 Note

In case Business Calendar is not specified, action time is calculated with the date coverage from 2001/01/01 00:00:00 to 2099/12/31
24:00:00.

In case timestamp before 2001/01/01 00:00:00 is used, define a business calendar.

 

 Note

Maximum size of zip file to be downloaded is 100 megabytes.

 
Event repetition

If there is data that shows that the same event is being repeated, you can change how to treat these repetitions.

For example, there are the following processes.

1. Event A -> Event C

2. Event A -> Event B -> Event C

3. Event A -> Event B -> Event B -> Event C

4. Event A -> Event B -> Event B -> Event B -> Event C

- Treat all distinct

This distinguishes not only by the existence of repetitions, but also by the number of repetitions.

In the above examples, processes 1 to 4 would all be distinct routes.
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- Ignore repetitions of more than twice

The existence of repetitions is taken into account, but otherwise there is not distinction made.

In the above examples, processes 1 to 3 would all be distinct routes, but routes 3 and 4 would be the same. As a result, three types of
routes would be identified.

- Ignore all repetitions

The existence of repetitions is not taken into account. In other words, the only the existence of an event is considered when
distinguishing routes.

In the above examples, processes 1 and 2 would all be distinct routes, but routes 2, 3, and 4 would be the same. As a result, two types
of routes would be identified.

 
Adding process data

From the Process Data Generation tab, select Add Process Data to add newly generated process data to the process data you already have.

- Put the new CSV in a different directory.

Create directory different to the one used to when the model was generated and store the CSV file in there.

When adding process data, there must be the same number of CSV files with the same names in the new directory as in the directory
originally used for generation. Delete the column header rows that have the field names if the files have them.

Click Add Process Data when the files have been stored in the new directory.

6.7 Business Calendars
When calculating the action time between events, you can use a business calendar that reflects the working hours in your business. Specify
this predefined calendar file when generating a process to take the calendar into account.

6.7.1 Creating a Business Calendar
A business calendar is a file with a ".cal" extension where the file name is 50 characters or fewer. Any character may be used in the name.

The format of a business calendar is "item=value". The following table lists the various items with their respective values.

The following table describes these options.

 
Item Value Required/Optional

EVERYDAY Define business hours by specifying time or by using a reserved word; is case
insensitive

Time range

HH:MM,H'H':M'M';

HH:MM indicates the start of business hours and H'H':M'M' indicates the end
of business hours.

Multiple intervals can be specified. (Up to five)

If you do specify multiple intervals and some of these intervals overlap, they
are still treated as business hour definitions.

For example: If the series 9:00,14:00;10:00,15:00 is specified, business hours
will be from 9:00 to 15:00.

Using a reserved word

"ALL_TIME" is a reserved word that can be used to indicate a 24-hour
operation.

Required
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Item Value Required/Optional

If the item is entered in the file but no hours are specified, the entire time will be
considered out of business hours (holidays).

Day of week Define business hours by specifying SUN, MON, TUE, WED, THU, FRI, SAT;
is case insensitive

Use the same time format as "EVERYDAY".

If this item is entered, the values entered for "EVERYDAY" will be overwritten.

Optional

Year/month/day Define business hours by specifying the date in the

YYYY/MM/DD format; this date format is fixed

Use the same time format as "EVERYDAY".

If this item is entered, the values entered for "EVERYDAY" and day of the week
will be overwritten.

Optional

CALENDAR_BEGIN

*1

Specify a start date for the calendar in the

YYYY/MM/DD format.

Required

CALENDAR_END

*1

Specify an end date for the calendar in the

YYYY/MM/DD format.

Required

*1: Events occurring outside the range delimited by CALENDAR_BEGIN and CALENDAR_END will be considered to have occurred
on a holiday.

Example 1: To define a calendar where Saturdays and Sundays are off, there is a six-day year-end break, and the business hours for every
other day are between 9:00 and 17:00:

EVERYDAY=9:00,17:00;

SAT=;

SUN=;

2011/01/01=;

2011/01/02=;

2011/01/03=;

2011/12/29=;

2011/12/30=;

2011/12/31=;

CALENDAR_BEGIN=2001/01/01;

CALENDAR_END=2099/12/31;

Example 2: To define a calendar where Sundays are off, Saturday business hours are between 9:00 and 12:00, business hours on 12 August
are between 13:00 and 17:00, and the business hours for every other day are from 9:00 to 12:00, and then, from 13:00 to 17:00:

EVERYDAY=9:00,12:00;13:00,17:00;

SAT=9:00,12:00;

SUN=;

2011/08/12=13:00,17:00;

CALENDAR_BEGIN=2001/01/01;

CALENDAR_END=2099/12/31;

Example 3: To define a calendar for a business that operates around the clock:

EVERYDAY=ALL_TIME;

CALENDAR_BEGIN=2001/01/01;

CALENDAR_END=2099/12/31;

6.7.2 Using Business Calendars
To begin using a business calendar, save the business calendar you have created at the following location:
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<Analytics data directory>/bpme/calendar

For example: C:/ibpmm_data/bpme/calendar
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Chapter 7 Process Analyzer Overview

7.1 Window Configuration

7.2 Getting Started
 

Preparations

Set up the Process Discovery database before using the Process Analyzer.

Refer to Chapter 4,"Installing and Setting Up Analytics Server" in the Installation Guide for details.

 
Creating users and assigning groups

Create users, and assign them to groups to log into the Analytics Console.

Assign users to the Process Analyzer User group if they only need to use the Process Analyzer.

Assign users to the Process Analyzer Power User group if the user needs to configure fixed-point monitoring linked with Analytics. This
allows the user to use the Process Analyzer, Analytics Dashboard, and Analytics Studio.

Refer to the Management Console Guide for details.
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Starting the Analytics Console

Specify the following URL to display the Analytics Console.

http://[ServerName]:[PortNumber]/ibpmm/

Select the Process Analyzer tab to begin analyzing business processes.
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Chapter 8 Process Analyzer Features

8.1 Operation Menus
 

File

The File menu contains the following menu options.

- Select Model

Allows you to select a model for display

Refer to "8.2 Selecting Model" for details.

- New Window

Displays the process diagram in a new window; if you have set a filter criteria, it will be retained

- Save As

Save process diagrams as SVG, PNG, and XPDL

- Download CSV

- Process Analysis tab

Allows you to download CSV files containing the Action Count or Statistics for process diagrams

- Route Analysis tab

Allows you to download CSV files containing the Route List, Action Details, Action Count, or Process ID

Refer to "8.11 Download CSV" for details.

 
View

The View menu contains the following menu options.

- Zoom

Zoom in or out, or show the entire business process.

Refer to "8.3 Control Panel" for details.

- Process Endpoints

Displays "INITIAL_STATE" at the beginning and "FINAL_STATE" at the end

- Typical Process

Displays the typical processes

Refer to "8.3.2 Discover Typical Process" for details.

- Event Search Bar

Displays a search bar that provides options to search for events using the event's display name or its actual name

Refer to "8.4.6 Event Search Bar" for details.

- Control Panel

Invokes the Control Panel

- Properties of Model

Displays the number of processes displayed, Cost Average, Process Update Time, and Filter Criteria

- Action

- Count

Displays action count
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Refer to "8.3 Control Panel" for details.

- Time

Displays time details, such as average action time and standard deviation in the process diagram.

Refer to "8.3 Control Panel" for details.

- Time Unit

Selects from Days, Hours, Minutes, and Seconds

- Sequential Number

Displays sequential number in the process diagram

Note that sequential numbers are only available for the Route Analysis tab.

- Fixed Event Mode

Displays processes with fixed event positions regardless of configuring the Process Filter

If this mode is used, the following functionalities are not available:

- Save As

- Process Comparison Display

 
Tools

- Analyze

- Filter

Indicates filter criteria for narrowing down.

Refer to "8.4.4 Set Filter Criteria" for details.

- Pareto Chart

Displays the Pareto Chart.

Refer to "8.8 Pareto Chart" for details.

- Process Details

Searches process details using the Process Search Key.

Refer to "8.9 Process Details Search" for details.

- Process Comparison Display

Displays process diagrams using process properties as comparison parameters

Refer to "8.10 Property Comparison Display" for details.

- Cost Settings

Allows you to assign costs for events and actions

Refer to "8.4.5 Cost Settings" for details.

- Options

- Set Maximum Visible Events and Action

Sets maximum number of events and action displayed in a process diagram.

(It may take much time if large number is set.)

- Date Format

Configures the date format to be displayed in the process diagram
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Help

- Help

Displays the help contents

- About Process Analyzer

Displays the version and copyright information of Process Analyzer

8.2 Selecting Model
Select a model whose process you want to display.

The following describes the items in the Select Model dialog box.

 
Name Description

Model Name Displays the model name

Last Modified Displays the date when the model was last updated

Update Updates the window

Show [button] Displays the process diagram for the selected model

Set Event Display Name

[button]

Enables editing of the event's display name

Refer to "Edit Event Display Name" for details

Download Action Information as
CSV... [button]

Allows you to download CSV files that contain the action
information

Refer to "8.11 Download CSV" for details.
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Edit Event Display Name

You can edit the event name, given when the process was generated, to be used as the event's display name.

The following describes the items in the Event Display Name Settings dialog box.

 
Name Description

Event Name Displays the event name

Event Display Name Type a display name for the event

Enter "\n" for line feeds

Import from CSV... [button] Imports a CSV file to enter a number of event display names at
once.

The CSV file is one line per event, event name in column one and
display name in column two.

(A header row is unnecessary.)

Export to CSV... [button] Event display names currently being edited are exported to a CSV
file

Apply [button] Applies the event display name

Cancel [button] Closes the dialog box without modifying event name

 

 Note

The display names INITIAL_STATE and FINAL_STATE cannot be edited.

8.3 Control Panel
The Control Panel has various controls for the process view.
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Zoom Zoom Out Zooms in on a business process

Zoom In Zoom out from a business process

Display All Adjusts the zoom factor so that the whole business process is shown

Process Filter Slider Move the slider to change which processes are displayed based on their
frequency. The display refreshes when the slider is dragged and then released.
The percentage selected with the slider is the rate of accumulated processes
compared to the total.

Refer to "8.3.1 Slider" below for details.

Route Count Displays the number of routes for the selected frequency

Total Process Count Displays the number of processes in the model
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Show Typical Process Moves the slider to the frequency previously determined to display the
Typical Process

Refer to "8.3.2 Discover Typical Process" below for information on Typical
Processes.

Display Option Actions Count Displays the action count on action arrows

Show
Action
Time In

Average Displays the average action time on action arrows.

Standard
Deviation

Displays the standard deviation of the action time on action arrows.

Highlight
Bottlenecks

The actions taking the longest average time are emphasized in red (default).

Time Unit Select the units used for time displays; Days, Hours, Minutes, and Seconds.

8.3.1 Slider
 

Operations

Move the slider to display processes corresponding to the selected frequency. The display refreshes when the slider is dragged and released.
The slider and the Route Count box are linked. The values in the Route Count box change as you move the slider. Enter a number
between 0 and 100 and the slider will move to the relevant position.

The percentage selected with the slider is the rate of accumulated processes compared with the total.

When a model is selected, the slider is set to a percentage indicative of the Typical Process for that model.

 
Principles used to determine the display

Processes that follow the same actions in the same order are allocated the same route. These routes are then sorted by the number of
processes that they account for. Routes are then allocated percentages. A percentage of a route is calculated by comparing the number of
processes covered by that route added to the processes in the routes with higher frequencies and the total number of all processes.

The slider points to a percentage and any routes allocated that percentage or lower are displayed.

The following is an example.

In this example, there are three routes; Route1, Route2, and Route3. There are 100 processes in Route1, 50 in Route2, and 20 in Route3.

With the routes sorted by the number of processes they account for, the order looks like this.

 
Route Process

Route1 100

Route2 30

Route3 20

Total
Amount

150

Now we will allocate the percentages, calculated by adding the number of processes cumulatively.

 
Route Process Sum of processes from routes with

higher frequencies
Percentage

Route1 100 0 0% (0/150)

Route2 30 100 67% (100/150)

Route3 20 130 87% (130/150)

So here, if the slider is anywhere between 0% and 66%, only Route1 is displayed. If the slider is then moved between 67% and 86%,
Route1 and Route2 are displayed. If the slider is then moved above 87%, all the routes (Route1, Route2, and Route3) are displayed.
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Even if processes have been filtered by Property, Action Time, or Event, the slider always uses the data from all processes for its percentage
calculations.

8.3.2 Discover Typical Process
The Typical Process has three or fewer inputs and three or fewer outputs per event, and is the one that is the drawn using the highest
frequency percentage. When deciding whether a process is typical, consider the following:

- Do not count actions where the Action Source and Action Destination are the same event

- Do not count edges that connect to the INITIAL and FINAL events

If process diagram do not meet this conditions, all processes are drawn.
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8.4 Process Analysis

The following table shows operations available when an element drawn on a process is right-clicked. The "○" symbol indicates that the
operation is available for an element.

 
Event Action (when

INITIAL and
FINAL are not
included)

INITIAL,
FINAL

Action (when
INITIAL and
FINAL are
included)

Field

Show Processes ○ ○ ○ ○ -

Filter Processes by this Event ○ - - - -

Show Property Distribution ○ - ○ - -

Show Action Time Distribution - ○ - - -

Set Cost of Event ○ - - - -

Set Cost of Action - ○ - - -

Create Chart - ○ - - ○

Create Alert ○ ○ - - ○

Download CSV ( Process ID including
this Event)

○ - - - -

Download CSV ( Process ID including
this Action)

- ○ - - -

Zoom In Process Diagram ○ ○ ○ ○ ○

Zoom Out Process Diagram ○ ○ ○ ○ ○

Reset Zoom ○ ○ ○ ○ ○

Display All ○ ○ ○ ○ ○

 
Outline

- Show Processes

Displays processes that pass through the event or instance
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Refer to "8.4.1 Show Processes" below for details.

- Filter Processes by this Event

Display processes that include the selected event

A search that includes the event name is automatically created and specified in the Filter Criteria.

To remove the event name as a condition, go to Tools > Analyze > Filter to display the Define Filter Criteria dialog box and remove
the event name.

- Show Property Distribution

Displays the distribution of property values for the selected event or for the process that passes through the event

Refer to "8.4.2 Show Property Distribution" below for details.

- Show Action Time Distribution

Displays the time distribution for the selected action as well as the total action time for each property value

Refer to "8.4.3 Show Action Time Distribution" below for details.

- Set Cost of Event

Specify a value to the selected event

Refer to "8.4.5 Cost Settings" below for details.

- Set Cost of Action

Specify a value to the selected action

Refer to "8.4.5 Cost Settings" below for details.

- Create Chart

Set a chart KPI that is linked to Analytics for an event or action

Refer to "8.7.2 Creating Charts" below for details.

- Create Alert

Set an alert KPI that is linked to Analytics for an event or action

Refer to "8.7.1 Creating Alerts" below for details.

8.4.1 Show Processes
Displays processes that pass through the event or instance
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Process Display

The following describes the items in the Process Display dialog box.

 
Item Description

Route List Displays a list of processes that pass through events or actions selected in a business process.
Select a route from the list to show a list of processes included in the route in the Process
List area below.

Frequency Displays the frequency of processes in a route

Repeats Displays the repetition frequency of a route

Route ID Displays a number that identifies a route

Route Displays the order of events in a process

Events are put onto a time line and connected with arrows.

The number of times an event repeats consecutively is shown in brackets to the right of an
event class (not shown if there are no repeats).

Process List Displays a list of processes included in routes selected in the Route List

Process ID Displays the process ID

Execution Time Displays the time taken for execution of a process

Show Details Displays details about a process. Select the process, and then click the Show Details button
to show the details in a separate window.

Close Closes the dialog box.
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Process Details

Selecting the Show Details button displays the Process Details dialog box with the following options:

 
Item Description

Execution Time Displays the time taken for execution of a process

Process ID Displays the process ID

Execution order display area Events in the process are displayed in the order they occurred. Select an event to show a list
of the properties belonging to that event in the Event Property area below.

Order Displays the order of the event

Event Displays the event name

Occurrence Time Displays the time and date for the event

Accumulated Time Displays the accumulated time

Event Property Displays a list of the properties belonging to the event selected in the Execution order display
area

Property Name Displays the Property Name

Property Value Displays the Property Value

Exit Closes the dialog box

8.4.2 Show Property Distribution
Displays the distribution of property values of the selected event or of the process that passes through the event

Filter criteria can be automatically set by specifying a range of the histogram.
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Property Distribution Display

Displays a histogram showing the distribution of the property values of the selected event

The following table describes the items in the dialog box.

 
Item Description

Visible Processes This is displayed as a percentage of process display volume

Event Displays the names of events that have been made selected for property distribution display

Event (list) Displays "Complete Process" and event name which is included in the process that possesses
the selected event.

Complete Process

Property values, which are included in the process that possesses the selected event, are
targeted.

Event Name

Property values which are included in the selected event are targeted.

Property (list) Displays properties which are included in the selected event from the event list.
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Item Description

Property Value Selects some parameters related to displaying property values

Interpret Property Value As Select whether to treat the selected property as a string or numeric value

String Specify this to treat the selected property as a string

Numeric Specify this to treat the selected property as a number

Lower Bound Boundary
Value

Specifies the lower boundary of the histogram. Specify this when attributes are to be treated
as numbers.

Numbers, periods, and hyphens can be entered.

The default is the minimum value in the display condition range.

Width of Section Specify the width intervals in the histogram. Specify this when attributes are to be treated
as numerical attributes.

Numbers and periods can be entered.

The default is the result of dividing the range between minimum and maximum values in
the display condition range by 20 minutes.

No. of Sections Specify the number of intervals in the histogram. Specify this when attributes are to be
treated as numerical attributes.

Numbers and periods can be entered.

The default is 20.

Range of Selection Displays the selected range of selection

Initial Display Restores the default display

Add Value To Filter Automatically sets filter criteria and close the dialog box.

Available when a filter criteria range is specified on the histogram.

Exit Closes the dialog box

Specifying a filter criteria

Specify a range to filter by selecting histogram elements. The range specifiable by the property values can be selected.

 
Click Select a single element

Ctrl click Select multiple elements

Shift click Select the range of elements from the previously selected element to the current
element

Drag Drag the mouse across multiple elements to select them

8.4.3 Show Action Time Distribution
Displays the distribution of time for the selected action, and the total action time for each property value

Filter criteria can be automatically set by specifying a range of the histogram.
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The following describes the items in the Action Time Distribution dialog box.

 
Item Description

Visible Processes This is displayed as a percentage of process display volume.

Action Displays the selected event action.

List of details for action time Refer to "List of details for action time" below for details.

Action Time Select some parameters related to displaying action time

Time Unit Select days, hours, minutes, or seconds for the time display.

Lower Bound Boundary
Value

Specify the lower boundary of the histogram.

Numbers, periods, and hyphens can be entered.

The default is the minimum value of the display condition range.

Interval Specify the intervals in the histogram

The default is the result of dividing the range between minimum and maximum values in the
display condition range by 20 minutes.

Interval Count Specify the number of intervals in the histogram.

The default is 20.

Comparison Property Select the properties in the process included the selected action as the properties to compare.

Event This is a list of event included in the displayed process. Select "Complete Process" to select
the entire process.

All events in the entire process will be compared if you select "Complete Process".
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Item Description

Property Displays a list showing the properties of the event selected in the list of events.

Property Value Selects some parameters related to displaying property values

Interpret Property Value
As

Specify how property values are to be evaluated.

Value Property values are evaluated as strings. The Property Value Standard Boundary Value and
Width of Property Value Section cannot be selected.

Range The property values are treated as numbers and the ranges are evaluated. The Property Value
Standard Boundary Value and Width of Property Value Section can be selected.

Boundary Value Specify the lower boundary for property values.

Interval Specify the width of property value sections.

Range of Selection Displays the selected range of selection

Initial Display Restores the default display.

Add Value to Filter Automatically sets filter criteria and close the dialog box.

Available when a filter criteria range is specified on the histogram.

Exit Closes the dialog box.

 
List of details for action time

Values are displayed in the list of details for action time according to whether you have specified property values in Comparison Property.

 
Item Description

No. Displays the sequential number

Average Time Displays the average time taken for execution

The displayed units can be changed by selecting different time units.

Standard Deviation Displays the Standard Deviation

Maximum Time Displays the Maximum Time

The displayed units can be changed by selecting different time units.

Minimum Time Displays the Minimum Time

The displayed units can be changed by selecting different time units.

Count Displays the number of actions that include the property value

This may not necessarily equal the number of processes because the same action may occur
more than once in one process (caused by repetitions or rework).

Property Value/Section Displays the property value or the section of the property value

View This links to the histogram, showing or hiding it.

 
Examples of Comparison Property

This illustrates an example that there are three processes including action of "Accept -> Publish estimation".

Processes (property = Person Name):

1. Accept (Tanaka) -> Publish estimation -> Confirmation -> Delivery (Saito)

2. Accept (Tanaka) -> Publish estimation -> Design -> Delivery (Yamada)

3. Accept (Suzuki) -> Publish estimation -> Design -> Confirmation -> Delivery (Yamada)

Action time of "Accept -> Publish estimation" is as follows respectively:

- 71 -



1. 20 minutes

2. 60 minutes

3. 40 minutes

Under this condition, followings are displayed in the list of details for action time.

Event: "Accept", Property: "Person Name"

 
Average Time Maximum Time Minimum Time Count Property Value

40 minutes 60 minutes 20 minutes 2 Tanaka

40 minutes 40 minutes 40 minutes 1 Suzuki

Event: "Delivery", Property: "Person Name"

 
Average Time Maximum Time Minimum Time Count Property Value

20 minutes 20 minutes 20 minutes 1 Saito

50 minutes 60 minutes 40 minutes 2 Yamada

Event: "Complete Process", Property: "Person Name"

 
Average Time Maximum Time Minimum Time Count Property Value

40 minutes 60 minutes 20 minutes 2 Tanaka

40 minutes 40 minutes 40 minutes 1 Suzuki

20 minutes 20 minutes 20 minutes 1 Saito

50 minutes 60 minutes 40 minutes 2 Yamada

8.4.4 Set Filter Criteria
You can filter the processes displayed by specifying conditions such as property values, periods, and event statuses.
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The following describes the items in the Filter Criteria dialog box.

 
Item Description

No. Condition number

State The states displayed are "New", "Change", and "Set".

"New" is the state of conditions that have been newly added.

"Change" is the state of conditions that have been changed after they were set.

"Set" is the state of conditions that were already set before opening the Filter Criteria dialog box.

Type The types displayed are "Property", "Period", "Event", and "Action Time".

"Property" indicates that you have specified a property filter criteria.

"Period" indicates that you have specified a period filter criteria.

"Event" indicates that you have specified an event filter criteria.

"Action Time" indicates that you have specified an action time filter criteria.

Operation Displays condition combinations

Nothing is displayed at the top of the list

AND is displayed in other places on the list. (Only the AND operation is used.)

Condition Displays the details of the conditions you have set.
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Item Description

The display for each type is as follows.

[Properties]

For numeric values: A.Data=-011

For strings: A.Data='011'

[Period]

2011/06/31 00:00:00-2011/12/31 23:59:59 (overlap ON)

2011/06/31 00:00:00-2011/12/31 23:59:59 (overlap OFF)

[Event]

Including A.Time

Not including A.Time

[Action Time]

1h <= A.Time -> B.Time

1h <= A.Time -> B.Time < 2h

A.Time -> B.Time < 2h

If the filter criteria has already been set, you can display the content of the setting in the lower part of the dialog box by selecting a filter
condition.

 
Operations

The following describes the operations available in the Filter Criteria dialog box.

 
Item Description

Add Adds a filter criteria.

Refer to "8.4.4.1 Adding Filter Criteria" below for details.

Delete Deletes a condition selected in the list

Apply Executes the filter using the set conditions

Cancel Closes the Filter Criteria dialog box

8.4.4.1 Adding Filter Criteria
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Property Filter Criteria

The following table describes the options that appear when you add a property filter criteria.

 
Item Description

Target This is a list box with the event names. Select "Complete Process" to select the entire process.

Property Name This is a list box with the property names. These are the names allocated to properties when the process
is generated, and are used for analysis.

Specify the property name from the list for the events specified in Target.

Property Type Select the property type.

String This indicates that the value specified is to be evaluated as a string.

This can be selected for any property.

Numeric This indicates that the value specified is to be evaluated as a number.

This can be selected when the values for the selected property can all be treated as numbers.

Condition Set the conditions.

Operator Select "=" (equal), "!=" (not equal), "<=" (less than), or ">=" (greater than) as an operator.

The less than and greater than operators can be selected when evaluating numbers.

Value This is a list box with the values of the specified properties.

If equal or not equal has been selected as the operator, only Condition1 needs to be set. If less than or
greater than has been selected as the operator, Condition1 and Condition2 need to be set.

OK Applies the filter criteria.
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Period Filter Criteria

The following table describes the options that appear when you add a period filter criteria.

 
Item Description

Start Date Specify the start date for the period.

Select the checkbox to enable input.

End Date Specify the end date for the period.

Select the checkbox to enable input.

Include Partly Overlapped Processes Select the checkbox to include processes that overlap the start and end dates.

OK Applies the filter criteria.

 
Event Filter Criteria

The following table describes the options that appear when you add an event filter criteria.
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Item Description

Event Filter Criteria Specify the event filter criteria

Event Name Specify the event name to show only those events that match the given name.

Not Use Select the checkbox to display events whose Include Type is "Not Use".

Include Select the checkbox to display events whose Include Type is "Include".

Exclude Select the checkbox to display events whose Include Type is "Exclude".

Event Name Displays the event name.

Event Condition Specify the event condition.

Not Use Do not specify as a filter criteria.

Include Specify that the event must be included.

Exclude Specify that the event must be excluded.

OK Applies the filter criteria.

 
Action Time Filter Criteria

The following table describes the options that appear when you add an action time filter criteria.

 
Item Description

Action Displays a list of event names used in the Process View.

Set the event name for the Action Source and the event name for the Action
Destination.

The event display name or event name can be used as the action event.

Time Unit Select days, hours, minutes, or seconds for the time unit.

Condition Set the action time to be used as the condition.

Selects the checkbox to enable input.

Numbers and periods can be entered.

If the condition is not set, processes including the specified action name are
included in the search.
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Item Description

OK Applies the filter criteria.

 

 Point

Process Analyzer allows you to retain the filter criteria after you have logged out or closed the browser.

To use this feature, ensure the following settings are configured:

- Local Storage settings of the Flash Player

1. Right-click the Process Analyzer tab, and then click Settings.

2. On the Local Storage tab, clear the Never Ask Again check box

- Privacy settings of the Flash Player

1. Grant the permission to store the information

8.4.5 Cost Settings
Set numerical values for events and actions.

The costs can then be used to see the total cost for different routes.
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Applying the values in a batch from the Tools menu

The following describes the Cost Settings dialog box, accessible from the Tools menu.

 
Item Description

Event/Action Switch between setting costs for events and actions.

Event Name Displays the event name.

Action Displays the action

Cost Enter costs.

Numbers and periods can be entered.

Clear Resets all costs to 0.

Import... Specifies a CSV file to import to make cost settings in a batch.

Export... Outputs a CSV file containing all the current cost settings.

Apply Executes cost settings.

Cancel Closes the dialog box.

 
Format of the CSV file for cost settings

This is the format of the header for the CSV file.

type, display_name, original_name, cost

Set the following values in each of the columns.

type

Enter "event" when specifying a cost for an event and "action" when specifying a cost for an action. Any other string is ignored.
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display_name

Enter the event display name or action display name.

(The strings entered here are not evaluated upon import.)

original_name

Enter the event name or action name.

This is ignored if the event or action does not exist.

The format for the action name is as follows.

Action Source event name=>Action Destination event name

cost

Specify the cost.

This is ignored if the entered value cannot be treated as a number.

 
Applying costs individually to events and actions

The following describes the Cost Settings dialog box, accessible from events and actions in a process diagram.

For events, right-click the event and click Set Cost of Event.

For actions, right-click an action and click Set Cost of Action.

 
Item Description

Event Name/Action Displays the event or action name.

Cost Input costs.

Numbers and periods can be entered.

Apply Executes cost settings.

Cancel Closes the dialog box.

8.4.6 Event Search Bar
Click View > Event Search Bar to display a search option that enables you to search for events in a process. Focus shifts to the event
that meets the conditions entered.

 
Item Description

Text Box Enter the search string.

Enter "\" for line feeds.

Event Display Name Search/
Event Name Search

Select whether to search by display name or event name.

Search Starts the event name search.

The search string is case sensitive and event names that partially match are considered
matches.

Focus shifts to the next event if more than one event matches the conditions.

Exit Closes the event search bar.
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8.5 Route Analysis
You can display details for business processes and actions in the routes* displayed by the current process frequency.

* A route is a particular pattern of actions in a process.

8.5.1 Route List
In the Process Analyzer, select the Route List tab to display details of each route.

 
Column Header

 
Item Description

Route Count Displays the number of routes.

Visible Processes Displays the selected process display volume as a percentage.

Sort Displays the Route Sorting dialog box.

Refer to "8.5.1.1 Route Sorting" below for details.

<< button Displays the first page.

This button is disabled if the number of pages is 0 or 1, or if the first page is being displayed.

< button Displays the previous page.

This button is disabled if the number of pages is 0 or 1, or if the first page is being displayed.

> button Displays the next page.

This button is disabled if the number of pages is 0 or 1, or if the last page is being displayed.

>> button Displays the last page.

This button is disabled if the number of pages is 0 or 1, or if the last page is being displayed.

Text box (to specify page
number)

Enter a page number and press the Enter key to go to that page.

Total number of pages displayed Displays the total number of pages

 
Route List

Click the items in the column header to sort by ascending or descending order.

The units displayed for time correspond to the units selected in the Control Panel.

The maximum number of items that can be listed is 500.The page changes when this is exceeded.

 
Item Description

Route Displays the route.

Route ID Displays a number that indicates the route.

Frequency Displays the total number of instances.
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Item Description

Average Time Displays the average time taken for execution.

Maximum Time Displays the Maximum Time taken for execution.

Minimum Time Displays the Minimum Time taken for execution.

Repeats Displays the repetition frequency.

Refer to "8.5.1.2 Repeats" below for details.

Loopbacks Displays the loopbacks.

Refer to "8.5.1.3 Loopbacks" below for more details.

Cost Displays the cumulative total for all the events and actions that make up the route. Event types with no
cost settings are treated in calculations as having a cost of 0.

Sort Score The score is displayed if the button for sorting has been clicked.

Refer to "8.5.1.1 Route Sorting" below for details.

 

 Note

Route cannot be displayed if too many events are included in a route.

8.5.1.1 Route Sorting
Click Sort in Route Analysis to display the Route Sorting dialog box. There are two methods of sorting: List Routes containing these
actions first and List Routes that do not meet the condition below first.
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List Routes containing these actions first

When this option is selected, the numbers of action arrows in between particular Action Sources and Action Destinations are used as a
score and the processes are sorted accordingly.

 
Item Description

Action Source Specify the name of the event to be used as the Action Source. A list box with the event names (display
names) plus the INTIAL_STATE event is displayed.

INITIAL_STATE is the default selection.

Action Destination Specify the name of the event to be used as the Action Destination. A list box with the event names
(display names) plus the FINAL_STATE event is displayed.

FINAL_STATE is the default selection.

 
List Routes that do not meet the condition below first

When this option is selected, a score of 1 is given to processes that meet both of the following conditions. Other processes receive a score
of 0, then the processes are sorted accordingly.

- The event specified as the Target Event occurs in the process.

- Events specified as prerequisites have not occurred before the Target Event.

(If the Target Event occurs multiple times throughout the process, the one closest to the Target Event is the one evaluated.)

 
Item Description

Target Event Specify the Target Event. A list box with the event names (display names) is displayed.

Target Event
Precondition

Specify the prerequisites. Press the Ctrl key or Shift key to select more than one prerequisite. A
list with the event names (display names) is displayed.

8.5.1.2 Repeats
"Repeats" is the total number of times that events occur in succession in a particular process.

A → B → B → C → D → D → D

We will use the above process as an example. The numbers of actions indicate the order of execution. Event B is executed twice (repeated
once) and event D is executed three times (repeated twice). The total of all such repetitions in the entire process is 3.
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8.5.1.3 Loopbacks
"Loopbacks" is the total number of recurrences of events in a process.

A → B → C → D → B → C → D → E → D → E

We will use the above process as an example. The numbers of actions indicate the order of execution. Actions 4 and 8 are seen as recurring,
so the loopbacks is 2. Actions 5, 6, and 9 recurred due to the rework, so they are not counted.

8.5.2 Process View Panel
Displays the process view for the selected routes

This panel has the same features as the shortcut menu in the Process Analysis window.
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8.5.3 Action Details Panel
Displays the action details for selected routes

Click the items in the column header to sort by ascending or descending order.

The units displayed for time correspond to the units selected in the control panel.

 
Item Description

No. Displays the number allocated to an action according to its
order of occurrence.

Action Displays the action.

Frequency Displays the action frequency.

Average Time Displays the average time taken for the action.

Maximum Time Displays the maximum time taken for a action.

Minimum Time Displays the minimum time taken for a action.
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8.6 Exceptional Route Analysis
This view is used to focus analysis on processes that exhibit exceptional behavior, for example a large number of repetitions. Routes that
are not displayed when a certain percentage is specified are considered to be exceptional and are included in the list.

8.6.1 Exceptional Process View
This displays details about the exceptional processes for each route.

 
Column Header

 
Item Description

Exceptional Route Count Displays the number of exceptional routes.

Visible Processes Displays the selected process display volume as a percentage.

Sort Displays the Route Sorting dialog box.

Refer to "8.5.1.1 Route Sorting" above for details.

<< button Displays the first page.

This button is disabled if the number of pages is 0 or 1, or if the first page is being displayed.

< button Displays the previous page.

This button is disabled if the number of pages is 0 or 1, or if the first page is being displayed.

> button Displays the next page.

This button is disabled if the number of pages is 0 or 1, or if the last page is being displayed.

>> button Displays the last page.

This button is disabled if the number of pages is 0 or 1, or if the last page is being displayed.

Text box (to specify page
number)

Enter a page number and press the Enter key to go to that page.

Total number of pages displayed Displays the total number of pages.

 
Exceptional Route List

Click the items in the column header to sort by ascending or descending order.

The units displayed for time correspond to the units selected in the control panel.

The maximum number of items that can be listed is 500.The page changes when this is exceeded.

 
Item Description

Exceptional Route Displays the route.

Frequency Displays the total number of instances.
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Item Description

A lower number of instances indicate a higher chance that the process is exceptional.

Deviation Degree Displays the degree of deviation.

Refer to "8.6.1.1 Deviation Degree" below for details.

Repeats Displays the repetition frequency in the exceptional process.

Refer to "8.5.1.2 Repeats" above for details.

Loopbacks Displays the loopbacks in the exceptional process.

Refer to "8.5.1.3 Loopbacks" above for details.

Cost Displays the cumulative total for all the events and actions that make up the sequence in an
exceptional process. Event types with no cost settings are treated in calculations as having a
cost of 0.

Sort Score The score is displayed if the button for sorting has been clicked.

Refer to "8.5.1.1 Route Sorting" above for details.

8.6.1.1 Deviation Degree
"Deviation degree" is defined as the number of operations on events required to morph the standard process into the exceptional process
being considered.

Any of the following operations on events are counted.

- Insert

- Remove

- Replace

Any of the processes currently displayed by the percentage selected with the slider may be considered candidates for the standard process.
A tentative deviation degree is calculated for each of these against the exceptional process being considered. Of these, the lowest deviation
degree is displayed as the 'official' one.

Here is an example.

8.6.2 Process View Panel
The actions for selected exceptional processes are shown as red broken lines.
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The following table shows operations available when an element drawn on a process is right-clicked.

 
Event Action (when

INITIAL and
FINAL are not
included)

INITIAL,
FINAL

Action (when
INITIAL and
FINAL are
included)

Field

Show Processes ○ ○ ○ ○ -

Filter Processes by this Event - - - - -

Show Property Distribution - - - - -

Show Action Time Distribution ○ - - - -

Set Cost of Event - - - - -

Set Cost of Action - ○ - - -

Create Chart - ○ - - ○

Create Alert ○ ○ - - ○
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8.7 KPI Configuration
Set a KPI that is linked to Analytics for an event or action.

When monitoring events over time, an extracted process can be set as a monitoring point and used as a KPI.

This feature is used for fixed-point monitoring of business using Process Discovery. Refer to Chapter9 for details.

8.7.1 Creating Alerts
 

Alert Creation

In a displayed process, right-click an element and click Create Alert to display the Alert Creation dialog box.

The following table describes the various options of the Alert Creation dialog box.

 
Item Description

Alert Name Specify the alert name.

The name entered here is used as the Analytics alert definition name.

KPI Type Select alert types from the list.

Repetition - When you open the Alert Creation dialog box of an event, the frequency of repetitions of the
event is set as a threshold value for monitoring.

- When you open the Alert Creation dialog box of an action, the frequency of repetitions of the
Action Source event of the action is set as a threshold value for monitoring.

When you open the Alert Creation dialog box of a field, the frequency of repetitions of the
entire process is set as a threshold value for monitoring.

Exceptional Action A particular action can be monitored for unexpected activity.

Action Delay - When you open the Alert Creation dialog box of an event or action, the execution time of the
selected action is set as a threshold value for monitoring.

When you open the Alert Creation dialog box of a field, the execution time of the entire process
is set as a threshold value for monitoring.

Repetition Count Set the repetition frequency to be used as the threshold value.

Available when Repetition is selected as the KPI Type.

Alert Action Set the Action Source event and the Action Destination event for the action that will trigger the
alert.

Available when Exceptional Action is selected as the KPI Type.

Default value
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Item Description

- When you open the Alert Creation dialog box of an event, it displays the selected event name
on the Action Source event name.

- When you open the Alert Creation dialog box of a action, it displays the selected action event
name on the Action Source and Action Destination event names.

When you open the Alert Creation dialog box of a field, there is no default value.

[Add] Displays the Filtering by Event Name dialog box used to search for event names in existing
processes.

Refer to "Filtering by Event Name dialog box" below for details.

Action Set the Action Source event and the Action Destination event for the action whose action delay is
to be monitored.

Available when Action Delay is selected as the Alert Type.

Default value

- When you open the Alert Creation dialog box of an event, it displays the selected event name
on the Action Source event name.

When you open the Alert Creation dialog box of a action, it displays the selected action event
name on the Action Source and Action Destination event names.

Action Time Sets the action delay to be used as the threshold value. Select days, hours, minutes, or seconds for
the time unit.

Available when Action Delay is selected as the Alert Type.

Alert Message Enter the message to be displayed when an alert occurs.

The message entered here is used as the Alert Message in the Analytics alert definition.

Create Creates an Analytics alert definition.

Cancel Closes the dialog box without creating an Analytics alert definition.

 

 Point

Alert definition is created with following parameters.

- Type : Critical

- Level : 100

Note that input alert message is used in common between English and Japanese.

Edit using Analytics Studio if necessary.
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Filtering by Event Name dialog box

This displays a dialog box that has a list of event names that can be selected for use when specifying actions when setting up alerts for
exceptional actions or when specifying actions for action delay alerts.

The list can be filtered by entering the first few characters of the event name.

If you have edited a name, that is the name that is displayed.

Select the name from the list and click Apply to have that name applied to the previous window.

8.7.2 Creating Charts
 

Creating charts for a particular action

In a displayed process, right-click an action and click Create Chart to display the Chart Creation dialog box.
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The following table describes the various options of the Chart Creation dialog box.

 
Item Description

Chart Name Enter a chart name.

The name entered here is used as the Analytics chart definition name.

Comparison Category Select Comparison Category for the KPI values from the list.

This selection is then used as an item in the chart definitions in the Analytics Studio.

None Nothing is used for comparison. KPI values are shown on a one-dimensional chart.

Property Properties are used for comparison.

Select from the properties set for analysis when the process was generated.

Process Processes are used for comparison.

Route Routes are used for comparison.

Time Line The time axis is used for comparison.

KPI Select KPI values from the list.

Action Time (ave) Use the average action time as a KPI value.

Available when "None", "Property", "Route", or "Time Line" is selected as the Comparison
Category.

Action Time (max) Use the maximum action time as a KPI value.

Available when "None", "Property", "Route", or "Time Line" is selected as the Comparison
Category.

Action Time (min) Use the minimum action time as a KPI value.

Available when "None", "Property", "Route", or "Time Line" is selected as the Comparison
Category.

Action Time Use the action time as a KPI value.

Available when "Process" is selected as the Comparison Category.
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Item Description

Action Count Use the action time as a KPI value.

Available when "None", "Property", "Route", or "Time Line" is selected as the Comparison
Category.

Chart Type Select chart types from the list.

Line Chart Use the Line Chart.

Available when "Property", "Route", or "Time Line" is selected as the Comparison Category.

Bar Chart Use the Bar Chart.

Available when "Property", "Route", or "Time Line" is selected as the Comparison Category.

Tachometer Use the Tachometer.

Available when "None" is selected as the Comparison Category.

Signal Use the Signal.

Available when "None" is selected as the Comparison Category.

Process Filter Specify how many processes to display in the KPI chart.

The current process display volume is the default.

Upper Threshold Set the upper threshold value.

Specify "Days", "Hours", "Minutes", or "Seconds" if the KPI value is one of the following; "Action
Time", " Action Time (ave)", " Action Time (max)", " Action Time (min)".

There is no upper threshold if nothing is entered.

Lower Threshold Set the lower threshold value.

Specify "Days", "Hours", "Minutes", or "Seconds" if the KPI value is one of the following; " Action
Time", " Action Time (ave)", " Action Time (max)", " Action Time (min)".

There is no lower threshold if nothing is entered.

Create Creates an Analytics chart definition.

Cancel Closes the dialog box without creating an Analytics chart definition.

 
Creating charts for the entire process

Right-click in the Process Analysis tab and select Create Chart from the context menu to display the Chart Creation dialog box. This
dialog box enables you to create a chart for the entire process.
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The following table describes the various options of the Chart Creation dialog box.

 
Item Description

Chart Name Enter a chart name.

The name entered here is used as the Analytics chart definition name.

Display Type Select the KPI display type from the list.

Comparison of
Action

Displays KPI values for each action.

The action ID is used for the Analytics chart definition category.

The action ID is made up of the "Action Source event name", an underscore, and the "Action
Destination event name".

Comparison of Route The KPI values are shown on the chart for each route.

The Route ID is used for the Analytics chart definition category.

KPI Rate each
Process

The KPI values are shown on the chart as percentages for each process.

The process identifier is used as an item in the Analytics chart definition.

The action ID is used for the Analytics chart definition series.

KPI Rate each Route The KPI values are shown on the chart as percentages for each route.

The route identifier is used as an item in the Analytics chart definition.

The action ID is used for the Analytics chart definition series.

KPI Select KPI values from the list.

Action Time (ave) Use the average action time as a KPI value.

Available when "Comparison of Action", "Comparison of Route", or "KPI Rate each Route" is
selected as the Display Type.

Action Time (max) Use the maximum action time as a KPI value.

Available when "Comparison of Action", "Comparison of Route", or "KPI Rate each Route" is
selected as the Display Type.
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Item Description

Action Time (min) Use the minimum action time as a KPI value.

Available when "Comparison of Action", "Comparison of Route", or "KPI Rate each Route" is
selected as the Display Type.

Action Time Use the action time as a KPI value.

Available when "KPI Rate each Process" is selected as the Display Type.

Action Count Use the action time as a KPI value.

Available when "Comparison of Action" or "KPI Rate each Route" is selected as the Display Type.

Repetition Count Use the repetition frequency as a KPI value.

Available when "Comparison of Route" is selected as the Display Type.

Chart Type Select chart types from the list.

Line Chart Use the Line Chart.

Available when "Comparison of Action" or "Comparison of Route" is selected as the Display Type.

Bar Chart Use the Bar Chart.

Available when "Comparison of Action" or "Comparison of Route" is selected as the Display Type.

Stack Bar Chart Use the Stack Bar Chart.

Available when "KPI Rate each Process" or "KPI Rate each Route" is selected as the Display Type.

Process Filter Specify how many processes to display in the KPI chart.

The current process display volume is the default.

Upper Threshold Set the upper threshold value.

Specify "Days", "Hours", "Minutes", or "Seconds" if the KPI value is one of the following; "Action
Time", " Action Time (ave)", " Action Time (max)", " Action Time (min)".

There is no upper threshold if nothing is entered.

Available when "Comparison of Action" or "Comparison of Route" is selected as the Display Type.

Lower Threshold Set the lower threshold value.

Specify "Days", "Hours", "Minutes", or "Seconds" if the KPI value is one of the following; " Action
Time", " Action Time (ave)", " Action Time (max)", " Action Time (min)".

There is no lower threshold if nothing is entered.

Available when "Comparison of Action" or "Comparison of Route" is selected as the Display Type.

Create Creates an Analytics alert definition.

Cancel Closes the dialog box.

 

 Point

Chart definition is created with following parameters.

- Period of Each Step : Latest data

Note that unit of action time is "second".

Edit using Analytics Studio if necessary.

8.8 Pareto Chart
Use Pareto charts to visually represent the concentration of routes.
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Click Tools > Analyze > Pareto Chart to display the Pareto Chart dialog box.

The following table lists the options in the Pareto Chart dialog box.

 
Item Description

Model Name Displays the model name.

Route Count Displays the number of routes found from amongst all processes generated.

Total Process Count Displays the number of all processes generated.

Event Type Count Displays the number of event types found in all processes generated.

Event Count Displays the number of events found in all processes generated.

Pareto Chart Displays the Pareto Chart.

Process Count The vertical axis on the left side of the chart is the number of processes, and the bars show the
number of processes per route.

The routes with the most number of processes are displayed first from the left.

Ratio The right hand vertical axis is a percentage corresponding to the cumulative rate of routes
compared to the total.

8.9 Process Details Search
Click Tools > Analyze > Process Detail to display the Process Details dialog box.
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Specify process search keys to display the events that make up the process and the properties of those events.

This allows you to learn more about the details of processes where alerts occurred due to threshold values (set as alert KPI in the Process
Analyzer) being exceeded. Charts shown for separate process instances can be used to learn more about processes that have been identified
as bottlenecks.

 
Item Description

Process Search Key This is used for searching process details.

The process search keys can be checked in the Analytics Dashboard.

Only number can be input.

Other details about the Process Details Search are the same as covered in the "8.4.1 Show Processes" section above.

8.10 Property Comparison Display
This feature displays a process diagram using the property values of a process as comparison parameters.
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Define Property Comparison Criteria dialog box

 
GUI Option Description

Event Select an event that has properties.

If "Complete Process" is selected, all the events in a process will be included.

Property Name Select a property name to be included in the comparison.

Property Value 1 Select a property value to be included in the comparison.

Property Value 2 Select another property value to be included in the comparison.

If the Except Property Value 1 check box is selected, all values except the one selected as
Property Value 1 will be included in the comparison.

Apply Use this button to apply the property comparison criteria, and display a process diagram.

Cancel Use this button to close the dialog box.

 
Process display

The process diagram is narrowed down to only display processes with the comparison properties selected for Property Value 1 or Property
Value 2.

In this case, a blue arrow is drawn for an action that includes a process with Property Value 1, and an orange arrow is drawn for an action
that includes a process with Property Value 2. A black arrow is drawn for an action with both Property Value 1 and Property Value
2.
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GUI Option Description

Display Criteria Use this button to display the set comparison properties.

Reset Use this button to cancel the set comparison properties.

 
Features that can be used with property comparison display

- Menu options

- Select Model

- Event Search Bar

- Properties of Model
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- Shortcut menu

- Zoom In Process Diagram

- Zoom Out Process Diagram

- Reset Zoom

- Display All

- Show Processes

- Control panel

- Zoom

- Process Filter

- Count

The Route Analysis and Exceptional Route Analysis tabs cannot be used.

 
Examples illustrating property comparison display

This section provides examples of property comparison display based on the processes given below. (The values for the "Person in charge"
property are in parentheses.)

 
ID001: Accept.Time (Saito) → Confirmation.Time (Saito) → Estimation.Time (Saito)

ID002: Accept.Time (Tanaka) → Confirmation.Time (Tanaka) → Cancel.Time (Suzuki)

ID003: Accept.Time (Suzuki) → Confirmation.Time (Suzuki) → Reject.Time (Suzuki)

Example 1

Comparison properties specified

Event: Complete Process

Property name: Person in charge

Property Value 1: Saito

Property Value 2: Tanaka
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The display is narrowed down to process ID001 with Saito as the Person in charge, and process ID002 with Tanaka as the Person in
charge.

The transition from "INITIAL_STATE" to "Accept.Time" and the transition from "Accept.Time" to "Confirmation.Time" include
both processes ID001 and ID002, so they are drawn using black arrows.

The transition from "Confirmation.Time" to "Estimation.Time" and the transition from "Estimation.Time" to "FINAL_STATE"
include process ID001 only, so they are drawn using blue arrows.

The transition from "Confirmation.Time" to "Cancel.Time" and the transition from "Cancel.Time" to "FINAL_STATE" include
process ID002 only, so they are drawn using orange arrows.

Example 2

Comparison properties specified

Event: Complete Process

Property Name: Person in charge

Property Value 1: Tanaka

Property Value 2: Suzuki
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The display is narrowed down to process ID002 with Tanaka and Suzuki as the Person in charge, and process ID003 with Suzuki as
the Person in charge.

The transition from "INITIAL_STATE" to "Accept.Time" and the transition from "Accept.Time" to "Confirmation.Time" include
both processes ID002 and ID003, so they are drawn using black arrows.

The transition from "Confirmation.Time" to "Cancel.Time" and the transition from "Cancel.Time" to "FINAL_STATE" include
process ID002 only, but this process has both Tanaka and Suzuki as the Person in charge, so they are drawn using black arrows.

The transition from "Confirmation.Time" to "Reject.Time" and the transition from "Reject.Time" to "FINAL_STATE" include process
ID003 only, so they are drawn using orange arrows.

Example 3

Comparison properties specified

Event: Accept.Time

Property Name: Person in charge

Property Value 1: Tanaka

Property Value 2: Suzuki
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The display is narrowed down to process ID002 with Tanaka as the Person in charge of Accept.Time, and process ID003 with Suzuki
as the Person in charge of Accept.Time.

The transition from "INITIAL_STATE" to "Accept.Time" and the transition from "Accept.Time" to "Confirmation.Time" include
both processes ID002 and ID003, so they are drawn using black arrows.

The transition from "Confirmation.Time" to "Cancel.Time" and the transition from "Cancel.Time" to "FINAL_STATE" include
process ID002 only, so they are drawn using blue arrows.

The transition from "Confirmation.Time" to "Reject.Time" and the transition from "Reject.Time" to "FINAL_STATE" include process
ID003 only, so they are drawn using orange arrows.

Example 4

Comparison properties specified

Event: Accept.Time

Property Name: Person in charge

Property Value 1: Saito

Property Value 2: (Except Property Value 1)
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Displayed are process ID001 with Saito as the Person in charge of Accept.Time, and process ID002 and ID003 with a person other
than Saito as the Person in charge of Accept.Time.

The transition from "INITIAL_STATE" to "Accept.Time" and the transition from "Accept.Time" to "Confirmation.Time" include all
processes, so they are drawn using black arrows.

The transition from "Confirmation.Time" to "Estimation.Time" and the transition from "Estimation.Time" to "FINAL_STATE"
include process ID001 only, so they are drawn using blue arrows.

The transition from "Confirmation.Time" to "Reject.Time" and the transition from "Reject.Time" to "FINAL_STATE" include process
ID003 only, so they are drawn using orange arrows.

The transition from "Confirmation.Time" to "Cancel.Time" and the transition from "Cancel.Time" to "FINAL_STATE" include
process ID002 only, so they are drawn using orange arrows.

8.11 Download CSV
The following table lists the Process Analyzer features that enable CSV download and their location in the GUI.

 
Downloaded Information Select Model dialog box Process Analysis tab Route Analysis tab

Download Action Information in
CSV [button]

Yes

Action Count (*1) Yes

Statistics Yes

Route List Yes

Action Details Yes

Action Count (*2) Yes

Process ID Yes

Process ID including this Event Yes Yes
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Downloaded Information Select Model dialog box Process Analysis tab Route Analysis tab

Process ID including this Action Yes Yes

*1: Action count for a process diagram

*2: Action count for a route list

 
Action information

The following action items included in all displayed processes can be downloaded in separate CSV files, and then compressed into a zip
file and downloaded. The zip file is named "modelName-actioninfo.zip".

- Action count (actioninfo-count.csv)

- Average action time (actioninfo-avg.csv)

- Standard deviation for the action time (actioninfo-sd.csv)

- Maximum action time (actioninfo-max.csv)

- Minimum action time (actioninfo-min.csv)

(The CSV file names are in parentheses.)

Unit of time

The unit of time is "seconds".

CSV header specification

The event name that is the origin of the action is downloaded in the second and subsequent rows of the first column. The event name
that is the destination of the action is downloaded in the second and subsequent columns of the first row.

 
Action Count (for a process diagram)

The action count for the actions included in the displayed processes can be downloaded as a CSV file.

The CSV file is named " modelName-count.csv".

CSV header specification

The event name that is the origin of the action is downloaded in the second and subsequent rows of the first column. The event name
that is the destination of the action is downloaded in the second and subsequent columns of the first row.

 
Statistics

The route count and the total process count of the displayed processes can be downloaded as a CSV file.

The CSV file is named "modelName-statistics.csv".

CSV header specification

In the first row, the percentage of processes displayed, the route count, and the total process count are downloaded.

In the second and subsequent rows of the first column, numbers from 10 through 100 in intervals of 10 are downloaded.

 
Route List

The items displayed in Route List on the Route Analysis tab can be downloaded as a CSV file.

All the routes displayed in Route List are included (to a maximum of 500).

The CSV file is named "modelName-routelist.csv".

CSV header specification

In the first row, items similar to those shown in the Route List are displayed.

 
Action Details

The items displayed in the Action Details area on the Route Analysis tab can be downloaded as a CSV file.
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The CSV file name is named "actiondetail-routeID.csv".

If this is selected from the menu, all the routes displayed in Route List will be included (to a maximum of 500), and these will be compressed
into a zip file and downloaded.

The zip file is named "modelName-actiondetail-route.zip".

If individual routes are selected, only those routes will be included.

CSV header specification

In the first row, items similar to those shown in Action Details are displayed.

 
Action Count (for a route list)

The action count for actions included in the processes that constitute individual routes can be downloaded as a CSV file.

The CSV file is named "count-routeID.csv".

If this is selected from the menu, all the routes displayed in Route List will be included (to a maximum of 500), and these will be compressed
into a zip file and downloaded.

The zip file is named "modelName-count-route.zip".

If individual routes are selected, only those routes will be included.

CSV header specification

The event name that is the source of the action is downloaded in the second and subsequent rows of the first column. The event name
that is the destination of the action is downloaded in the second and subsequent columns of the first row.

 
Process ID

The identifiers of the processes that constitute individual routes can be downloaded as a CSV file.

The CSV file is named "processid-list-routeID.csv".

If this is selected from the menu, all the routes displayed in Route List will be included (to a maximum of 500), and these will be compressed
into a zip file and downloaded.

The zip file is named "modelName-processid-list-route.zip".

If individual routes are selected, only those routes will be included.

 
Process ID including this Event

The identifiers of processes that include the selected event are downloaded as a CSV file.

The CSV file is named "modelName-processid-event.csv".

CSV header specification

The event name that is the source of the action is downloaded in the first column. The event name that is the destination of the action
is downloaded in the second column.

 
Process ID including this Action

The identifiers of processes that include the selected action are downloaded as a CSV file.

The CSV file is named "modelName-processid-action.csv".

CSV header specification

The event name that is the source of the action is downloaded in the first column. The event name that is the destination of the action
is downloaded in the second column.

 

 Note

Maximum size of CSV file or zip file to be downloaded is 100 megabytes.
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Chapter 9 Fixed-Point Monitoring of Business Using
Process Discovery

9.1 Overview
Use fixed-point analysis to monitor processes over an extended period. This may be necessary when changes are introduced after an As-
Is analysis using Process Discovery, or if some other inefficient activities have been introduced. Fixed-point monitoring allows you to
schedule the generation of processes so that they are generated at regular intervals. You can take advantage of this real-time feature to set
alerts for identified bottlenecks and to generate KPI charts that allow you to see the results of business improvement activities.

 

 Point

For fixed-point monitoring, an environment that has the same type of CSV data as the data used when the initial model was generated
should be prepared.

 

 Point

Users responsible for creating alerts or charts using the Process Analyzer must be assigned to the Process Analyzer Power User group.

9.2 Auto-Generation of Processes
To automatically generate processes for a model, you need to create an Analytics event for the model and activate the Process Discovery
sensor. As a result, when the CSV files in the CSV directory are updated, the Process Discovery sensor executes and the resultant processes
are automatically generated.

 
Creating an Analytics event

Use the Fixed-point Monitoring Settings tab in the Management Console to create an Analytics event for a model. You can then create
alerts and charts for this model using the Process Analyzer.
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GUI Option Description

Model Name Lists the models created using the Process Generator that have been generated correctly

Select a model to be configured for fixed-point monitoring

System Sensor Lists the sensors configured in Analytics

Default value is used in case multiple sensors are not configured

Event Group Lists the event groups configured in the Analytics Studio

Select an appropriate event group for the event you are creating; the default is System

Event Name Specify a meaningful name for the Analytics event definition; this is used in the Analytics Studio

Scheduler Click Enabled if fixed-point monitoring is to be performed according to a schedule

Schedule Type Specify how to save the process information that is generated

Click Accumulate Data to add new process information to existing process information; this option
should be selected if only differential business data is to be acquired

Click Update Data to overwrite existing process information with the newly generated process
information; this option should be selected if the entire business information is to be acquired every
time

Execution Schedule Set up the schedule for auto-generating processes

Create Creates a new fixed-point monitoring configuration

Modify Allows you to edit an existing fixed-point monitoring configuration

Delete Deletes a fixed-point monitoring configuration

 
Activating the Process Discovery sensor

Use the Connection Status tab in the Management Console to activate the Process Discovery sensor.

The Process Discovery Connection should be enabled.

 
Confirmation of the CSV directory monitored by the sensor

In the Model List page of the Process Generator, refer to the CSV Directory column to view the CSV directories being monitored by the
Process Discovery sensor.
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Update CSV files

Allows you to update CSV files in the Model List.

If the Scheduler is set to "Enabled" on the Fixed-point Monitoring Settings tab and the Process Discovery Connection is started, processes
are automatically generated when CSV files are updated.

Processes are generated on clicking this button.

9.3 KPI Alerts
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Flow chart for fixed-point monitoring using KPI alerts

 
Types of monitoring

Process Discovery supports the following monitoring techniques when integrated with the alert monitoring functions of Analytics.

Repetition monitoring

Threshold values are set to repeat specific events or entire processes.

Exceptional action monitoring

Monitoring is performed to identify actions that are not allowed or that must be performed.

Action delay monitoring

Threshold values are set for the action time between events or time taken for the entire process.

 

 Point

You can configure it further using the Analytics Studio. Refer to "8.7.1 Creating Alerts" for details about configuring alerts using the
Analytics Studio.

9.4 KPI Charts
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Flow chart for fixed-point monitoring using KPI charts

 
Chart KPI definitions for particular actions

The chart KPI definition can be set using the following perspectives for particular actions.

 
Comparison Category Chart Type KPI

None Tachometer, Signal Action Time (ave, max, min), Action Count

Property Line Chart, Bar Chart Action Time (ave, max, min), Action Count

Process Line Chart, Bar Chart Action Time

Route Line Chart, Bar Chart Action Time (ave, max, min), Action Count

Time Line Line Chart, Bar Chart Action Time (ave, max, min), Action Count

KPI values for Property

The properties for selected actions can be used, and the property values can be used as chart items to display KPI values on charts.

Specify this when focusing on properties as the cause of business bottlenecks.

KPI values for Processes

Process identifiers can be used as chart items to display KPI values on charts.

Specify this when focusing on processes as the cause of business bottlenecks.
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KPI values for Routes

Route identifiers can be used as chart items to display KPI values on charts.

Specify this when focusing on routes as the cause of business bottlenecks.

Chronological display of KPI values

The fixed-point monitoring schedule can be linked to the Analytics schedule to display KPI values in a chronological order.

This can be used to see the effects of business improvements over time.

 
Chart KPI definitions for an entire process

The chart KPI definition can be set using the following perspectives for an entire process.

 
Display Type Chart Type KPI

Comparison of Action Line Chart, Bar Chart Action Time (ave, max, min), Action Count

KPI Rate each Process Stack Bar Chart Action Time

Comparison of Route Line Chart, Bar Chart Action Time (ave, max, min), Repetition Count

KPI Rate each Route Stack Bar Chart Action Time (ave, max, min), Action Count

Comparison of Action

The actions in the overall process can be used as chart items to display KPI values on charts.

The identifier of an action comprises the name of the event where the action starts, an underscore, and the name of the event where
the action ends.

Specify this when focusing on actions as the cause of business bottlenecks.

KPI Rate each Process

KPI values are shown on the chart as percentage for each process.

The process identifier is used as the item, the action identifier is used for the series, and the action time is used as the KPI value. Specify
this when KPI of actions, including processes, are compared to identify the cause of business bottlenecks.

Comparison of Route

Routes can be used as chart items to display KPI values on charts.

The route identifier is the unique ID allocated on a system.

Specify this when focusing on routes as the cause of business bottlenecks.

KPI Rate each Route

KPI values are shown on the chart as percentage for each route.

The route identifier is used as the item, and the action identifier is used for the series.

Specify this when KPI of actions, including routes, are compared to identify the cause of business bottlenecks.

 

 Point

You can configure it further using the Analytics Studio. Refer to "8.7.2 Creating Charts" for details about configuring charts using the
Analytics Studio.
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 Point

For displaying charts when there are numerous actions, processes, and routes, controlling the plot volume is recommended. The Max
number of plots for category and Max number of plots for series can be configured using the chart settings in the Analytics Studio.
Refer to the Interstage Business Process Manager Analytics Studio Guide for details.

9.5 Drilling Down into Process Details
To drill down into process details, confirm the ProcessSearchKey from the alert details or the chart displayed in the Analytics Dashboard.

Use this ID as the Process Search Key.

Refer to "8.9 Process Details Search" for details.

Example: Alert details display
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Chapter 10 Analyzing IBPM Processes

10.1 Overview
If monitoring is configured for IBPM processes, the process data can be used by the Process Analyzer for process visualization. This is
useful for visualizing dynamic processes as process diagrams.

 

 Point

Only complete processes can be integrated for process visualization.

 

 Note

IBPM events cannot be configured for fixed-point monitoring.

10.1.1 Unit of Analysis
In case IBPM events are analyzed, the Model Series and the Project Name are used to manage a unit of analysis.

 
Model Series

Model Series is the process being analyzed. It uses the following naming convention.

Defined process

(Event Group Name)_(Event Name)_(Process Name)

Dynamic process

(Event Group Name)_(Event Name)_(Root Task Name)

Note that the Event Group Name and the Event Name are required for configuring IBPM processes for monitoring in Analytics.

 
Project Name

This represents the time period of event collection.

10.2 Setting Up Event Collection
 

Prerequisite

Ensure that the Process Discovery database is set up before you start event collection.

For details, refer to Chapter 4,"Installing and Setting Up Analytics Server" in the Interstage Business Process Manager Analytics
Installation Guide.

 
Scheduling event collection

Configure a schedule for IBPM event collection in the Management Console.
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GUI Option Description

Scheduler Click Enabled to generate data according to a schedule.

Execution Schedule Set up a schedule to generate IBPM events for use in Process Discovery.

Preservation Type Specify how the data will be stored.

Click Persistence to accumulate the data in Process Discovery.

Click Temporary to discard old data, and save the latest data in Process Discovery.

 

 Note

Restart the Analytics Server to apply the schedule.

 

 Point

The scope of event collection includes the time period between the previous event collection and the current time.

10.3 How to Start the Process Analyzer
Log in to the IBPM Console, and click the Analytics tab to display the Analytics Dashboard menu. In the Process Performance menu,
click Analysis and then click the appropriate profile to view its performance display.

The Process Analyzer can be started by clicking Analyze Process Patterns.

This button is displayed on clicking a:

- Process name (in case of a defined process)

- Root task name (in case of a dynamic process)
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10.4 Process Analyzer Features for IBPM Processes
This section covers Process Analyzer features specific to IBPM processes - processes whose Model Type is IBPM Event. All other
features are the same as covered earlier in this guide (Chapter 8 Process Analyzer Features).

10.4.1 Select Process Dialog Box
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10.4.2 Process Analyzer Window

 
Actions

Count

Displays the execution count of an event

 
Show Action Time in

Average

Displays the average action time for events; <Parallel> is displayed for concurrent events

Standard Deviation

Displays the standard deviation of the action time

10.4.3 Parallel Analysis
Use the Parallel Analysis tab to assess the extent of overlapping in event execution times (difference between the event start time and
end time). The overlapping is displayed for processes that have the same overlap pattern.
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GUI Option Description

Frequency Displays the frequency of processes for each overlap pattern of parallel execution

Average Time Displays the average time of processes for each parallel execution

Gantt Chart Displays the overlaps in execution time as a Gantt chart

Note that the length of the bars in the chart does not represent the actual execution time.

10.4.4 Process Details
For IBPM processes, both Occurrence Time and End Time are displayed in the Process Details dialog box.
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10.4.5 Limitations
The following features are not available for IBPM processes.

- Action time distribution

- Process details search

- Download CSV

10.5 Deleting IBPM Events
IBPM events can be deleted by using the Model List page in the Process Generator.

IBPM Event must be selected in the Model Type list to display models using IBPM events.
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Appendix A Parameter Ranges
This chapter describes some limitations of the parameters used in Process Discovery.

 
CSV fields used for analysis

 
No. Item Limitations

1 CSV file name Maximum of 100 characters

2 Characters allowed in the CSV file name ,/:"?*\<>|

Other than the above

3 CSV header column label length Maximum of 200 characters

4 Number of CSV header columns Maximum of 500

5 CSV column values

(Event Name Item, Timestamp Item, Property Item for Analysis)

Maximum of 200 characters

6 CSV column values (items other than those shown in number 5) Maximum of 500 characters

7 Characters allowed in CSV column values Other than Linefeed characters

8 Range of Timestamp allowed in business calendar 1980/1/1 - 2099/12/31

 
Process Generator

 
No. Item Target location Limitations

1 Model names Create Model dialog box

Rename Model dialog box

Maximum of 50 characters

2 Characters allowed in model names Space

Tab

Line-feed character

\/|,=:"*?<>&

Other than the above

3 Number of models Create New Model dialog box None

4 Length of path to the directory where the CSV is stored Create New Model dialog box /
Update Files

Edit CSV Directory dialog box

Maximum of 600
characters

5 Number of CSV files Create New Model dialog box /
Upload File

Edit CSV Directory dialog box

Maximum of 1000

6 Composite property name Set Composite Properties Maximum of
600characters

7 Characters allowed in composite property names Spaces

Tabs

Linefeed characters

,|"'<>&

Other than the above

8 Number of composite properties Set Composite Properties Maximum of 3000
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No. Item Target location Limitations

9 Number of selected properties (the number of items
that can be put together to make one composite
property)

Set Composite Properties Maximum of 15

10 Number of timestamps per CSV file Selection of Timestamp Item
and Event Name Item dialog
box / Timestamp Item

Maximum of 500

11 Number of timestamp items that can be joined Selection of Timestamp Item
and Event Name Item dialog
box / Event Name Item

Maximum of 10

12 Number of event name items that can be set in a CSV
File

Selection of Timestamp Item
and Event Name Item dialog
box / Event Name Item

Maximum of 10

13 Number of directories that can be added in the Edit
CSV directory dialog box

Generate Process Data Maximum of 10000

14 Number of property items for analysis Generate Process Data Maximum of 30

15 Event names Generate Process Data Maximum of 600
characters

16 Number of events per sequence Generate Process Data None

17 Property names Generate Process Data Maximum of 600
characters

18 Property values Generate Process Data Maximum of 600
characters

 
Process Analyzer

 
No. Item Target location Limitations

1 Display name Event Display Name Settings
dialog box

Maximum of 600
characters

2 Characters allowed in display names Except for:

"INITIAL_SATE"

"FINAL_STATE"

3 Number of digits in cost Cost Settings dialog box Integers: Maximum of 12
digits

Decimals: Maximum of 4
digits

4 Interval Count in Action Time Distribution Action Time Distribution Maximum of 100
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Appendix B Commands
This appendix explains the commands used in Process Discovery.

The commands are stored in the <Analytics installation directory>/bpme/bin.

 

 Information

Example for executing command in case of Linux environment:

/bin/sh (command name)

B.1 Importing and Exporting Models
Importing and exporting model data is necessary when backing up or when migrating to a different computer. This section explains the
commands used for importing and exporting models.

 
Exporting

The following command enables model data export:

bpmeprocessdata_export -m ModelName -d DirectoryPath [-na] -p AdminPassword

The exported data is output to the directory specified in the -d argument.

If -na is omitted, the data will be compressed and output to a file named "exp-<ModelName>.zip". If specified, a directory named "exp-
<ModelName>" is created and the data is output uncompressed.

The following table describes the arguments:

 
Arguments Description

-m ModelName Specify the name of the model to be exported.

-d DirectoryPath Specify the path to the output directory.

-na The exported data is not compressed if this argument is specified. This may be omitted.

-p AdminPassword Specify the super user password.

Exit Code

When command execution ends normally, value of 0 is returned. (Windows, Linux)

When command execution ends abnormally, value of -1 is returned. (Windows)

When command execution ends abnormally, value of 255 is returned. (Linux)

Models in the following states cannot be exported:

- Model linked with IBPM

- Model being worked on by a user in the Process Generator

 

 Note

The maximum compressed size for output data is 4 GB. Output the data uncompressed if it is going to exceed this size.

 
Importing

The following command enables model data import:
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bpmeprocessdata_import [-m ModelName] {-id DirectoryPath|-if FilePath} -od DirectoryPath -p 

AdminPassword

The model data exported with the export command can be specified either with the -id argument for the directory or with the -if argument
for the file. Specify the directory where the imported data is to be stored with the -od argument.

The following table describes the arguments:

 
Arguments Description

-m ModelName Specify the name of the model to be imported. If omitted, the model name used for export is used.

-id DirectoryPath Specify the path to the directory where the export data is located.

-if FilePath Specify the path to the file (zip) containing the export data.

-od DirectoryPath Specify the directory where the imported data is to be stored.

Prepare a unique directory for each model.

-p AdminPassword Specify the super user password.

Exit Code

When command execution ends normally, value of 0 is returned. (Windows, Linux)

When command execution ends abnormally, value of -1 is returned. (Windows)

When command execution ends abnormally, value of 255 is returned. (Linux)

B.2 Command to Forcibly Unlock Models in the Process
Generator

This section explains the command used to release the lock on models applied when they are being used in the Process Generator.

The following command enables unlocking of models in the Process Generator:

bpmeprocessgen_lockrelease [-r|-u filename] -p AdminPassword

Perform the following procedure:

1. Run the command using the -r argument, and output a list of lock statuses.

2. In the output list, for models that you want to unlock where "processing" is shown as "true", change to "false". (Changes from "false"
to "true" are not valid.)

3. Specify the updated list in the -u argument, and run the command.

The following table describes the arguments:

 
Arguments Description

-r Outputs the current lock status.

Outputs the lock status list (bpmeprocessgenlocklist.txt) to the same directory as the command.

-u fileName Updates the lock status.

This argument forcibly unlocks models being worked on by users.

-p AdminPassword Specify the super user password.

Exit Code

When command execution ends normally, value of 0 is returned. (Windows, Linux)

When command execution ends abnormally, value of -1 is returned. (Windows)

When command execution ends abnormally, value of 255 is returned. (Linux)
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The following table describes the items in the lock status list:

 
Headers Description

Processing Displays the lock status.

"true" indicates that the model is being worked on.

"false" indicates that the model is unlocked.

modelId Displays the model ID.

modelName Displays the model name.

statusCode Displays the status code.

userId Displays the user ID if "processing" is "true".

For example:

processing,modelId,modelName,statusCode,userId

true,1,Order1,7,userA

false,2,Quote,7,

false,3,Delivery,7,

 

 Note

The model cannot be forcibly unlocked under the following circumstances:

- While exporting

- While profiling

- While generating processes
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